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Introduction

This Lab Manual provides the step by step procedure to complete two labs in the MASTERs 23075 IoT6
Class.

If you don’t know how TCP/IP works but you have to add network connectivity to your product, this is the right class
for you. We will teach you the basics of TCP/IP, how the client-server model works, what ports and sockets are and
how applications use them to create TCP/IP connections. The class will also teach you the fundamentals of network
analysis with the well-known tool Wireshark. The hands-on part of the class utilizes Microchip's 32-bit MCUs with
MPLAB® Harmony. You can learn the architecture and the fundamentals of the Harmony TCP/IP stack to interface
your TCP/IP application with some common stack APIs. To make your life easier, the FreeRTOS™ task schedular is
used to simplify your application programming.

In Lab 1 we will open a TCP project, do some stack re-configuration and a connectivity check and in Lab 2 we will show an
Application integration for local access, using the example of a Vending machine. Finally in Lab 3 we will make an Application

integration for external access, using the example of a Weather Service.
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Hardware Requirements

The following hardware is required:
e SAM E70 Xpained Ultra (Microchip Part Number: DM320113)
o https://www.microchip.com/DevelopmentTools/ProductDetails/PartNO/DM320113

e OLED1 Xplained Pro extension kit (Microchip Part Number: ATOLED1-XPRO)
o https://www.microchip.com/Developmenttools/ProductDetails/ATOLED1-XPRO

e Cat 5 Ethernet Patch Cable
e USB Male A to USB Male B Micro Cable
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Software Requirements
The following software is required:
e Microchip MPLAB X IDE v5.20
o http://www.microchip.com/mplab

Microchip MPLAB XC32 Compiler v2.15

o http://www.microchip.com/mplab/compilers
Microchip MPLAB Harmony 3

o http://www.microchip.com/mplab/mplab-harmony
Microchip MPLAB Harmony Configuration (MHC) Tool Plugin v3.3.0.1
Tera Term v4.95

The Lab1l, Lab2 and Lab3 class expects a Harmony 3 with the following subset of Versions (Tags)
To make it more easy in the class for the attendees, the folder C:/MASTERs/23075 already contains this H3 Checkout

Z Configuration Database Setup @
Select and configure the packages that will be included in the current project:
[ B
Load Name Version Dependencies
V| |bsp v3.3.0 csp(3.2.1)
V| |core |v3.3.0 |csp(3.2.1)
V| |crypto v3.2.1 core(v3.2.1)
csp v3.2.1
V| |net v3.3.0 |core(3.2.1), csp(3.2.1), dev_packs(...

Configure Device Family and CMSIS Pack Paths:

DFP: .\dev_packs\Microchip\SAME70_DFP\4.0.26\same70b\atdf\ATSAME70Q21B.atdf

[
L) ®)

CMSIS: \dev_packs\arm\CMSIS\5.4.0

[ Launch ] [ Cancel l

In the (optional) case a standard Harmony 3 installation is used, in the MHC configuration the csp v3.2.1 and core v3.2.1 must be
selected. This can be done by clicking on the sub module and select in the drop down menu, the above mentioned version.
The following checkout could take several minutes. The checkout is only local, no external Github access will be used.

Z Configuration Database Setup @
Select and configure the packages that will be included in the current project:
[ B
Load Name Version Dependencies
audio v3.3.0 core(3.3.0), csb(3.3.0), usb(3.2.2), ...
bootload v3.0.0 csp(3.0)
V| |bsp v3.3.0 csp(3.2.1)
bt v3.3.0 core(3.3.0), csb(3.3.0), ush(3.2.2), ...
V] [core v3.2.1 lesp(3.2.1)
V| |crypto v3.2.1 core(v3.2.1)
csp v3.2.1
afx v3.3.0 core(3.3.0), bsp(3.3.0)
afx_apps v3.3.0 usb(3.2.1), gfx(3.3.0)
micrium_ucos3 v3.0.0 core(3.0)
.\l |motor_control v3.2.0 csp(v3.2.0)
V| |net v3.3.0 core(3.2.1), csp(3.2.1), dev_packs(...

touch v3.2.0 csp(v3.3.0
83.2.2 iv

Configure Device Family and CMSIS Pack Paths:

DFP: \dev_packs\Microchip\SAME70_DFP\4.0.26\same70b\atdf\ATSAME70Q21B.atdf

)
J

CMSIS: \dev_packs\arm\CMSIS\5.4.0

Launch ] [ Cancel ]
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How to connect the USB and the CAT5 Network cable to the board

- Ensure the Erase jumper is open

- Open the J805 jumper
ERASE Header
f Ethernet PHY
/ Header
DEBUG Se—
) = h ; = -
USB =t <

G

ananadil

g W

® Insert the LAN8740 PHY daughter board on the ETHERNET PHY MODULE header.

® Connect the micro USB cable from the computer to the DEBUG USB connector on the SAM E70 Xplained Ultra Evaluation Kit
® Establish a connection between the router/switch with the SAM E70 Xplained Ultra Evaluation Kit through the RJ45 connector

Insert PHY Daughter

Board
Insert USB

J
Ellllllll,:l

RSB L LLLLLLAR 1

Insert
..... Ethernet
sl Cable

Masandil
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Lab 1

Overview
Lab 1 will show you how to open an existing TCP/IP MPLAB Harmony 3 Project and using the MPLAB Harmony Configuration (MHC)
Tool. The project will incorporate basic TCP/IP functionality to allow the SAM E70 Xplained Ultra to connect to an Ethernet Network,
along with a simple application to flash a “Heartbeat” LED every 500ms. Once the project is generated and programmed onto the
development kit, you will use a number of techniques to validate that the PIC is connected to a network and determine its IP
Address. The concepts that will be covered in this lab include:
e Open a SAM E70 MPLAB X Project
o Configuring the MPLAB Harmony path
e Configuring the TCP/IP Stack options, including:
o Network Configuration of the Host Name
o TCP/IP Services including Dynamic Host Configuration Protocol Client, ICMPv4 Server (for Ping testing) &
Announce Discovery Tool
o Bandwidth testing with “iperf”
e Configuring the Harmony Console and Command Service for monitoring and control of the TCP/IP stack via a Terminal
Client running on a USB CDC Interface (Emulated RS232 COM Port).
Toggling the 10 Pin that drives USER_LEDO on the SAM E70 Xplained UltraSAM E70 Xplained Ultra
e Using the Windows Command Line Ping Tool and the Microchip TCP/IP Discovery tools to test connectivity of your SAM
E70 Xplained UltraSAM E70 Xplained Ultra on the network
e Use the Console and Command System to get help on available TCPIP Commands and execute a command to get

information about the network configuration.
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Lab Procedure
Starting MPLAB X IDE

1.1. Start MPLAB X IDE by double clicking on the MPLAB X IDE v5.20 icon found on the Windows desktop.

¥ MPLAB X IDE v5.20.

File Edit View Navigate Source Refactor Production Debug Team Tools Window Help IQv Search (Ctrl+])
PEES D@ TR0 -QB-d & (5 HowdoR
Kit Window | Start Page | MPLAB X Store |

MCU Boards SAM E70 Xplained Ultra

& SAM E70 Xplained Ultra

The Microchip SAM E70 Xplained Ultra (DM320113) evaluation kit is a hardware
platform to evaluate the Microchip ATSAME70Q21B microcontroller. Supported by
Microchip Technology Inc. tools including Atmel Studio & MPLAB X integrated
development platforms. This evaluation kit is the first of its kind hardware platform
compatible with XPRO extensions, X32 Daughter Board (Bluetooth & Audio), Modular
Graphics (GFX) interface, Modular Ethernet PHY interface, mikroBUS, and includes an
on-board Embedded Debugger (EDBG).

v External Links

% SAM E70 Datasheet
@ SAM E Series Product page

v Extension @ MPLAB Harmony

OLED1 Xplained Pro » Kit Information
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Project Load, modify with MHC, Generate, build and run

1. Open Project by choosing File»QOpen Project... from the main menu and select lab1 project

¥3 Open Project @
Lookin: | | MASTERs > £
11:5 — 3 .
Recent tems |~ . 23075 Project Name:
- | h3 web_net_server_nvm_mpfs_freertos_lab1
= | lab1
! o = | firmware Open Required Projects:
E=8=|sam_e70_xult_freertos.X
LEEET: & @src
& | lab2
e [+ | lab3
[+- | Lab_Manuals
My Docum... & | scripts
[+ | vm_server
A
Computer
-, 5
t&\ File name: C:\MASTERs\23075\lab1\firmware\sam_e70_xult_freertos.X Open Project
Network  Files of type: |Project Folder =

2. Open Project Properties by choosing
a. File»Project Properties from the main menu

b. Or select with a right click the project node in the project windows and select at the bottom

— History ¢ N

. Properties -

c. Or select the toolbox in the Dashboard

|

‘'m_m)fs_freertos_lab1 - Dashboard [APP_Tasks() - Navigator ]

| } web_net_server_nvm_mpfs_freertos_lab1
78 Project Type: Application - Configuration: sam_e70_xult_fre:
=} @ Device

= i ATSAME70Q21B
'@ : i Checksum: Blank, no code loaded
@) |=@ Packs

-@ SAME70_DFP (3.0.10)
@ CMSIS (5.0.1)

e e Tl VY DU DR RO
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3. Select the XC32 Compiler v2.15
4. Select the SAME70 Xplained by clicking on the SN: Number

3 Project Properties - web_net_server_nvm_mpfs_freertos_labl @
Categories: Configuration
- © General Family: Device:
[~ @ Hile Induslon/Bxusion Al Families v| |ATSAME70Q21B v
=t @ Conf: [sam_e70_xult_freertos] . :
~ © EDBG i
-0 Loading Supported Debug Header: Supported Plugin Board:
© Libraries None ¥ | |None v
©  Building
= i acks: ardware Tool: ompiler Toolchain:
= @ XC32 (Global Options) Pack Hardware Tool Compiler Toolchai
e @ xc32-as . Packs 00 PICkit 4 4 | [ 1. Compiler Toolchains
> xc32-gec ). SAME70_DFP - Pk -ARM
o xc32-qi+ P @ PM3 || *©ARM (v6.3.1) [c:\Program Fil¢
R I% . i 4.0.29 o Real ICE [=+XC32 [Download Latest
xe32- = ) CMSIS eliminpurel WY xC32 (v2.15) [C:\Program Fil
© xc32-ar - i o0 Snap L -0 XC32 (v2.10) [C:\Program Fil
) 1 Alternate Tools B ~-@ XC32 (v2.05) [C:\Program Fil
00 JTAGICE3 @ XC32 (v1.44) [C:\Program Fil
o PICKit2 @ XC32 (v1.42) [C:\Program Fil
o6 Powe Debugger [ ~@ XC32 (v1.40) [C:\Program Fil
50 Microchip Kits @ XC32 (v1.40) [C:\Program Fil
- PKOB nano
[=l-0o SAM E70 Xplained
: SN: ATML318607
+~00 mEDBG
~-@ Starter Kits (PKOB) ~
< | 1] | » « | > <l | »
L ' i ) )
’ PP S ] Tip: double click on serial number (SN) to use a friendly name (FN) instead.
[ OK ] [ Cancel ] [ Apply ] Unlock

5. Select from the Tools Menu the Harmony 3 Configurator
am_e70_xult_freertos
ram |Tools| Window Help

D Embedded » 2  MPLAB® Harmonv 3 Framework Downloader "“'E' 0,588
j— Licenses ‘P ) = MPLAB® Harmony 3 Configurator J’
| Packs W(

6. Ensure the H3 Path is set to “C:\MASTERs\23075\h3\”

“Z MPLAB Harmony Launcher s

Active Project Information:

Name: sam_e70_xult_freertos

Select an option to use for the launch paths for the MPLAB Harmony Framework tool suite:

|
(@) MPLAB Harmony Project Path - The framework path that is stored with this MPLAB Harmony project. Reconfigure Paths

Harmony Path: C:\MASTERSs\23075\h3

) MPLABX Path - The framework path that is stored with MPLABX (configured through Tools->Options->Harmony)

Harmony Path: C:\microchip\h3

Default Launch Action: :Prompt For Path Selection (This... v:
(Configurable through Tools->Options->MPLAB Harmony)

Launch ] [ cancel |

10
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7. Select “Launch”

dearcil KEsuILS | vulpur @ |
| . . |
'E’ Launching MPLAB® Harmony Configurator 5
Path: C:\MASTERs\23075\h3\

% Generating Configuration Database

The first time the MHC is started, it can take up to 2 Minutes before the Configuration Database is prepared

8. In the next window the H3 parts and their used Version Numbers are displayed

2 Configuration Database Setup @
Select and configure the packages that will be included in the current project:
i B
Load Name Version Dependencies
V| |bsp v3.3.0 csp(3.2.1)
V| |core v3.2.1 csp(3.2.1)
V| |crypto v3.2.1 core(v3.2.1)
csp v3.2.1

[ Inet v3.3.0 core(3.2.1), csp(3.2.1), dev_packs(...

Configure Device Family and CMSIS Pack Paths:

DFP: \dev_packs\Microchip\SAME70_DFP\4.0.26\same70b\atdf\ATSAME70Q21B.atdf D

CMSIS: .\dev_packs\arm\CMSIS\5.4.0 [:]

Launch ] [ Cancel ]

Click on “Launch”

9. Open the saved state file

2 Open Default Saved State @

Open default saved state file?

C:\MASTERs\23075\lab1\firmware\src\config\sam_e70_xult_freertos\sam_e70_xult_freertos.xml

: Open | [ Cancel
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10. The MHC is up and running

12

£ MPLAB Harmony Configurator - sam_e/U_xXult_reertos
‘ile Generate Tools Utilities Window

[E=SECE X ]

Framework: C:\MASTERs\23075\h3\

) P ) | P

=0

=0

(0 Available Components

# Board Support Packages (BSPs)
# Harmony

Libraries

- Packs

- Peripherals

# Third Party Libraries

# Tools

@ Project Graph

TCO
Peripheral Library.

SAM E70 Xplained Ultra BSP

U
Peripheral Library
UART

|
Harmony Core Service.
© RTOS
Core Service ©
MEMORY
Driver

@ Core Service
Instances -=—(-

DRV_MEDIA

(] Available Components (] Active Components

(] Console 4 (5|

Cryptographic (Crypto) Library
O SYS_TIME

CRYPTO 77i

TWIHSO
eripheral Library

12c 2

CONSOLE
System Service
© Core Service
S UART

T i TCP/IP STACK
SYS_CONSOLE
Y svs_rs

FILE SYSTEM

(] Configuration Options

(] Help (] Configuration Options

Welcome to the MPLAB Harmony Configurator!

11. Select Active Components (left below)

(] Available Components | (] Active Components

| (1 console = &
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12. Select the Instance 0 in Active Components

(] Active Components = B
X omER4¢
~ CMSIS Pack
CONSOLE
Core
~ Cryptographic (Crypto) Library
EFC
FILE SYSTEM
- FreeRTOS
- MEMORY
I Presentation Layer
SAM E70 Xplained Ultra BSP
System
TCO
= TCP/IP STACK
#- APPLICATION LAYER
= BASIC CONFIGURATION
= NETCONFIG

...[5
| i o

TCP/IP Basic Configurator
- TCPIP CMD
TCPIP CORE
TCPIP File System Wrapper
+- DRIVER LAYER
- NETWORK LAYER
# TRANSPORT LAYER
~ TIME

13. And change in the Configuration Options (on the right side) the Host Name to something meaningful for you.

The Host name can be identified in the Network.

(] Configuration Options =8
=
= NETCONFIG
Network Configurations Index 0r
Interface GMAC
Host Name MARTIN_RUPPERT
Mac Address 00:04:25:1C:A0:02
IPv4 Static Address 192.168.100.11
IPv4 SubMNet Mask 255.255.255.0
IPv4 Default Gateway Address |192.168.100.1
IPv4 Primary DNS 192.168.100.1
IPv4 Secondary DNS 0.0.0.0
~Power Mode full
#-Network Configuration Start-up Flags
Network MAC Driver DRV_GMAC_Object

13
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14. Select “TCP/IP Application Layer Configuration” in Active Components

(] Active Components =0
Xomom ¢

CMSIS Pack

CONSOLE

Core

Cryptographic (Crypto) Library
EFC

FILE SYSTEM

FreeRTOS

MEMORY

Presentation Layer

SAM E70 Xplained Ultra BSP
System

TCO

= TCP/IP STACK

= APPLICATION LAYER
ANNOUNCE

DHCP CLIENT

DNS CLIENT

HTTPNET SERVER
IPERF

NBNS

SMTP CLIENT

SNTP

- BASIC CONFIGURATION

t- DRIVER LAYER

H- NETWORK LAYER

- TRANSPORT LAYER

TIME

15. Ensure that ANNOUNCE and IPERF are selected

Exf

-1

U ]

fru]

(] Configuration Options
=&

5. TC0AD Annlicstion | suar Configurator
( ANNOUNCE
“Berkeley APT
DDNS

DHCP CLIENT
DHCP SERVER
DNS CLIENT

DNS SERVER

FTP SERVER
HTTPNET SERVER
HTTP SERVER
IPERF
TRBNSTTTTTTTTTT
REBOOT

SMTP CLIENT
SNMP

SNMPWV3

SNTP

TELNET

TFTP CLIENT

TFTP SERVER
ZEROCONF

A\

DDDDHDDHD@HJHDDHDHD[{H

14
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16. Select ICMPv4 in the Active Components

(] Active Components =& 5
X Zmeme
CMSIS Pack
CONSOLE
Core
Cryptographic (Crypto) Library
EFC
FILE SYSTEM
FreeRTOS
H-MEMORY
- Presentation Layer
SAM E70 Xplained Ultra BSP
System
TCO
= TCP/IP STACK
- APPLICATION LAYER
#- BASIC CONFIGURATION
#- DRIVER LAYER
= NETWORK LAYER
ARP
ICMPv4
ICMPv6
IPv4
IPv6
NDP
TCP/IP Network Layer Configurator
# TRANSPORT LAYER
TIME
TWIHSO
USART1

forn B wru |

17. And ensure that the “Use ICMPv4 Client” is selected

(] Configuration Options
(=] [+
=-ICMPv4
Use ICMPv4 Server
=-Use ICMPv4 Client
--Enable User Notification
-Echo request timeout - ms 500
- ICMP task rate - ms 33

414>

15
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18. Select “Code” (Generate Code)

aa

z  MPLAB Harmony Configurator - sam_e/(
‘ile Generate Toaple Llilitiac Window

N-NEX:

("1 Active Comnanents
19. Select Don’t Save

2 Modified Configuration

Current configuration has been modified. Do you want to save it before file generation?

[ Don't Save

]

Save As

20. Select Generate

-

2 Generate Project

1. Configure Generation Settings

=5

[l Generate Settings

Merge Strategy [USER RECENT

>)@

(Mouse over a property for detailed help)

2. View Warnings

Type Description

3. Click Generate

Generate ‘ l Cancel
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21. Some Files will be changed and the MHC is asking in a “diff” window, if the changes should be taken over.

Accept all changes in the file by clicking on the Arrow in the middle above.

2 Merging: configuration.h_8107676870428926504.0ld

Pending Merge Actions: 2

4 Previoud

Note: The content of the right pane displays the current state of this merge.

Generated Code

Current File: configuration.h_8107676870428926504.0ld

#define ICPIP IPV6 NDP MAX NEIGHBOR ADVERTISEMENT

23

#define ICPIP IPV6 NDP MAX NEIGHSOR ADVERTISEMENT 3 E
#define TCPIP_IPV6 NDP REACHABLE TIME 30 #define TCPIP IPV6 NDP_REACHABLE TIME 30
#define TCPIP IPV6 NDP RETRANS TIMER 1 #define TCPIP IPV6 NDP RETRANS TIMER 1
#define TCPIP IPV6_NDP DELAY FIRST_PROBE_TIME 5 #define 6_NDP_DELAY FIRST PROBE_TIME 5
#define TCPIP_IPV6 NDP VALID_LIFETIME TWO_HOURS (60 = 60 * 2) #define 3 NDP_VALID LIFETIME_TWO_HOURS (60 = 60 = 2)
#define TCPIP_IPV6 MTU INCREASE TIMEOUT 600 #define ICPIP IPV6 MTU INCREASE_TIMEOUT 600
#define TCPIP IPV6 NDP TASK TIMER_RATE 32 #define NDP_TASK TIMER RATE 32
340 340
/* Network Configuration Index 0 */ 341 341 |/* Network Configuration Index 0 */
#define TCPIP NETWORK DEFAULT_INTERFACE_NAME_IDXO  "GMAC" 342 342 |#define ICPIP NETWORK_DEFAULT INTERFACE NAME IDXO  "GMAC"
#define TCPIP IF GMAC 343 343 #define I P_IF_GMAC
344 344
#define TCPIP NETWORK DEFAULT HOST NAME IDXO "MARTIN RUPPERT" =P 345 345 #define TCPIP NETWORK DEFAULT HOST NAME IDXO "MCHPBOARD C"
#define TCPIP NETWORK DEFAULT_MAC ADDR IDXO "00:04:25: 1 2" 346 346 |#define TCPIP NETWORK DEFAULT_MAC ADDR IDXO
347 347
#define TCPIP NETWORK DEFAULT_IP ADDRESS_IDXO "192.168.100.11" 348 348 #define I P_NETWORK_DEFAULT_IP ADDRESS_IDX0 "192.168.100.11"
#define TCPIP NETWORK DEFAULT_IP MASK IDXO "255.255.255.0" 349 349 |#define I P_NETWORK_DEFAULT_IP MASK_IDXO "255.255.255.0"
#define TCPIP NETWORK DEFAULT_GATEWAY_IDXO "192.168.100.1" 350 350 |#define TCPIP NETWORK DEFAULT_GATEWAY_IDXO 192.168.100.1"
#define TCPIP NETWORK DEFAULT_DNS_IDXO "192.168.100.1" 351 351 |#define I = "192.168.100.1" P
#define TCPIP NETWORK DEFAULT_SECOND_DNS_IDXO "0.0.0.0" 352 352 #define TCPIP NETWORK DEFAULT_SECOND_DNS_IDXO "0.0.0.0" -
#define TCPIP NETWORK DEFAULT_POWER MODE_IDXO "full" 353 353 #define ICPIP NETWORK_DEFAULT_POWER_MODE_IDXO "full" 3
#define TCPIP NETWORK DEFAULT_INTERFACE_FLAGS_IDXO \ 354 354 |#define TCPIP NETWORK_DEFAULT INTERFACE_FLAGS_IDXO \ w
CPIP NETWORK_CONFIG DHCP CLIENT_ON |\ 355 355 ICPIP_NETWORK_CONFIG DHCP CLIENT_ON |\
356 356 TCPIP_NETWORK_CONFIG DNS_CLIENT_ON |\
357 357 TCPIP NETWORK_CONFIG IP STATIC
358 358
#define TCPIP NETWORK DEFAULT_MAC DRIVER_IDXO DRV_GMAC Object 359 359 #define TCPIP NETWORK DEFAULT_MAC DRIVER_IDXO DRV_GMAC Object
360 360
361 361
362 362
/*** £epip cmd Configuration ***/ 363 363 |/*** tepip cmd Configuration ***/
#define TCPIP STACK_COMMAND_ ENABLE 364 364 #define TCPIP STACK COMMAND_ENABLE
#define TCPIP STACK_COMMANDS_ICMP ECHO_REQUESTS 4 365 365 |#define TCPIP STACK COMMANDS_ICMP ECHO_REQUESTS 4
#define TCPIP STACK_COMMANDS_ICMP ECHO_REQUEST DELAY 1000 366 366 #define TCPIP STACK COMMANDS_ICMP ECHO_REQUEST_DELAY 1000
#define TCPIP STACK_COMMANDS_ICMP_ECHO_TIMEOUT 5000 367 367 |#define TCPIP STACK COMMANDS_ICMP ECHO_TIMEOUT 5000
#define TCPIP STACK_COMMANDS WIFI ENABLE false 368 368 #define TCPIP STACK COMMANDS_WIFI ENABLE false
#define TCPIP STACK_COMMANDS_ICMP ECHO_REQUEST_BUFF_SIZE 2000 369 369 #define TCPIP STACK COMMANDS_ICMP ECHO_REQUEST BUFF_SIZE 2000
#define TCPIP STACK_COMMANDS_ICMP ECHO_REQUEST_DATA_SIZE 100 370 370 #define TCPIP STACK COMMANDS_ICMP ECHO_REQUEST_DATA_ SIZE 100
371 a1
372 372 v
pane displays the current state o
.old
-~
‘FG RMII | \
2 Merging: tcpip_private.h_5816637879687640463.0ld
|| Pending Merge Actions: 1 & Ne
Note: The content of the right pane displays the current state of this merge.
Generated Code 11 Current File: tcpip_private.h_5816637879687640463.0ld
7/ X £ 0| [ 2
A pi‘:“: ’“"/ “‘“'/‘aq“ nverface - e 24 // private stack manager interface
inctude Meepip/sre/tepip managex_control. pod 95 #include "tcpip/src/tcpip_manager_control.h"
96
#include "topip/src/tepip_snnounce managesr.n 27 97 #include "tcpip/src/tcpip_announce manager.h"
#include "tcpip/src/ndp_manager.h" 98 -, .
— 98 #include "tcpip/src/ndp_manager.h"
#include "tcpip/src/ipv4_manager.h" 99 z
- 99 #include "tcpip/src/ipv4_manager.h"
#include "tcpip/src/ipvé_manager.h" 100 e
- 100 #include "tcpip/src/ipvé_manager.h"
#include "tcpip/src/icmpvé_manager.h" 101 o
- 101 #include "tcpip/src/icmpvé_manager.h"
#include "tcpip/src/dhcpvé_manager.h” 102 ol
- 102 #include "tcpip/src/dhcpvé_manager.h"
#include "tcpip/src/icmp_manager.n" 103 -
- 103 #include "tcpip/src/icmp_manager.h"
#include "tcpip/src/dncp_manager.n" 104 -
- 104 #include "tcpip/src/dhcp_manager.h"
#include "tcpip/src/arp_manager.n" 108 -
- 105 #include "tcpip/src/arp_manager.h"
#include "tcpip/src/dns_manager.n" 106 -
- 106 #include "tcpip/src/dns_manager.h"
#include "tcpip/src/tcp_manager.n” 107 -
= 107 #include "tcpip/src/tcp_manager.h"
#include "tcpip/src/nbns_manager.n" 108 -
- 108 #include "tcpip/src/nbns_manager.h"
#include "tcpip/src/nttp_net_manager.h" 109 -
- - 109 #include "tcpip/src/http_net_manager.h"
#include "tcpip/src/tcpip_commands_manager.h" 110 - -
- — 110 #include "tcpip/src/tcpip_commands_manager.h"
#include "tcpip/src/udp_manager.n" 111 - -
- 111 #include "tcpip/src/udp_manager.h"
#include "tcpip/src/sntp_manager.n" 112 -
- 112 #include "tcpip/src/sntp_manager.h"
#include "tcpip/src/lldp manager.n" 113 >
= = 7 113 #include "tcpip/src/lldp manager.h"
#include "tcpip/src/iperf h" =P 114
114 #include "tcpip/src/smtpc_manager.h"
#include "tcpip/src/smtpc_manager.h" 115 -
- 115 #include "tcpip/src/tcpip_packet.h"
#include "tcpip/src/tcpip_packet.n" 116 -
N Jude *t 9 /e *“ 1 te.h" e 116 #include "tcpip/src/tcpip_helpers_private.h"
#1nc1ud= " cplp/src cixp;A:"persiprlvn o 00 117 #include "tcpip/src/oahas "
include "topip/src/oanash. 118  #include "tcpip/src/hash_fav.h"
#include "tcpip/src/nash_fov.h" 119 =
- 119 #include "tcpip/src/tcpip_notify.h"
#include "tcpip/src/tcpip_notify.h" 120 120 -
121 121  #endif // TCPIP_STACK_PRIVATE H
#endif // _ TCPIP_STACK_PRIVATE_H__ 122 - — = - ——
123

17
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24. The whole process is displayed with a progress bar

|

e : . =

-2 Generating Project... X
Task Type Remaining Total
File Markup 0 482
File Copy 52, 482
Libraries 0 0
Settings 8 8
Source Paths i) 0

Generating file: C:\MASTERs\23075\h3\crypto\src\des3.c

25. Back again in the main window of MPLABX, click on the “Make and Program Device” button

freertos_labl : sam_e70_xult_freertos

tion Debug Tea_r'ri\yindow Help
T - - E @

=[] Start Page 5| MPLAB X Store

|| MCLI Rnarde

26. After successful build, the SAME70 is programmed automatically

Search Results |0utput %8 |

[ | EDBG = | Kits ] web_net_server_nvm_mpfs_freertos_lab1 (Build, Load, ...) =

AMQnT L& ) - LTQ vy “GirTwLwL y

e /UIDOD L LD LAY T D AQ A LWL Ty oQu

make[l]: Leaving directory 'C:/MASTERs/23075/labl/firmware/san

BUILD SUCCESSFUL (total time: 35s)

[Loading code from C:/MASTERs/23075/labl/firmware/sam e70_xult_
ction/sam e70 xult freertos.X.production.hex...
Loading completed
Connecting to programmer...
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27. The programming take about 30 seconds with on Board Debugger Check whether the USER_LEDO Activity is Blinking

Figure 1. SAM E70 Xplained Ultra Evaluation Kit with PHY Daughter Board

Activitiy Blinking

=

USER_LED®

JTAG Adaptor

Features

ATSAME70Q21 Microcontroller
One Mechanical Reset Button Click Board
One Mechanical User Push Button Adaptor

Two User LEDs

12.0 MHz Oscillator (DSC6003)
32.768 kHz Oscillator (DSC6083)
2-MB SDRAM

4-MB QSPI Flash (SST26VF032BA)

o)

Yy

Reset
Button

FEEFREEEEED

Aufsteckbarer
PHY
Daughter
Board Adaptor
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28. Open Terra Term Terminal Program IMUSKGHISUMIN and select under Setup->Serial Port the COM Port and the Baudrate

115200 (in this case a COM96, but could be a different COM Port number in your case).

The press the Reset Button of the Board and let the Firmware restart. You should see the start message with the Lab

name and the build timestamp at first, followed by the MAC Address from EEPROM.

29. After some small time, the IP Address should be change from 0.0.0.0 to a valid address

4 COM96:115200baud - Tera Term VT
File Edit Setup Control Window Help

web_net_server_nvm_mpfs_freertos_labl Jun 3 2019 19:30:07
SYS_Initialize: The MPFS2 File System is mounted
MAC TCPIP_HOSTS_CONFIGURATIONIO®].macAddr: fc:c2:3d:0c:20:44
TCP/IP Stack: Initialization Started
TCP/IP Stack: Initialization Ended - success

Interface GMAC on host MARTIN_RUPPERT - NBNS enabled
GMAC IP Address: 0.0.0.0
EHHC IP Address: 192.168.0.17

4 |11
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30. To check the basic information about the network enter the netinfo command and press .

Wl COM93:115200baud - Tera Term VT

File Edit Setup Control Window Help

>netinfo

—————————— Interface <eth®/GMAC> ————————-

Host Name: MARTIN_RUPPERT - NBNS enabled

IPv4 Address: 192.168.0.24

Mask: 255.255.255.0

Gateway: 192.168.0.1

DNS: 192.168.0.1

MAC Address: fc:c2:3d:0b:bf:f9

IPv6 Unicast addresses:
fe80:0:0:0:fec2:3dff:feBb:bff9
2a02:908:1d41:d520:fec2:3dff : febBb:bff9

IPv6 Multicast addresses:
ff02:0:0:0:0:1:ff0b:bff9
ff02:0:0:0:0:0:0:1

dhcp 1s ON

Link 1s UP

Status: Ready

>(]

21
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31. A help shows the available commands

File

&l COM93:115200baud - Tera Term VT

Edit Setup Control Window Help

I I

I

I I

I I

I

I

I I

I I

I

I

I I

I I

I

I

I I

I I

I

I

-— Supported command groups ————-
iperf: 1perf commands s

tcpip: stack commands =

————— Built in commands ————————-
reset: Reset host

q: quit command processor x
help: help s

>help tcpip

netinfo: Get network information xwx
defnet: Set/Get default interface xx=x=
dhcp: DHCP client commands =
dhcps: Turn DHCP server on/off m=sx
zcll: Turn ZCLL on/off s

setdns: Set DNS address

setip: Set IP address and mask »xx=
setgw: Set Gateway address xx=x
setbios: Set host’'s NetBIOS name xxx
setmac: Set MAC address

1f: Bring an interface up/down x=xx
stack: Stack turn on/off s
heapinfo: Check heap status »==x
ping: Ping an IP address =

arp: ARP commands

dnsc: DNS client commands s
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32. As afirst simple test you can ping an external Server or anything else you like (Maybe the board of your class neighbor?)

4 COM96:115200baud - Tera Term VT
File Edit Setup Control Window Help

=N ol ==

web_net_server_nvm_mpfs_freertos_labl Jun 3 2019 19:30:07
SYS _Initialize: The MPFS2 File System is mounted
MAC TCPIP_HOSTS_CONFIGURATIONI®].macAddr: fc:c2:3d:0c:20:44
TCP/IP Stack: Initialization Started
TCP/IP Stack: Initialization Ended - suc

Interface GMAC on host MARTIN_ RUPPERT = NBNS enabled
GMAC IP Address: 0.0.0.0
GMAC IP Address: 192.168.0.17

>ping www.google.com
Ping: resolving host: www.google.com
>Ping: replyll] from 172.217.23.132: time = 25ms

Ping: replyl2] from 172.217.23.132: time = 26ms
Ping: replyl3] from 172.217.23.132: time = 2oms
Ping: replyl4] from 172.217.23.132: time = 25ms

Ping: done. Sent 4 requests, received & replies.

4 |1
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33. Select the tcpip_discoverer tool from

E=8 Eol =

@Ovh » Computer » System (C:) » MASTERs » 23075 » h3 » net P utilities » tcpip_discoverer »

Organize ~

| MASTERs

| 23075
| h3
——ThspT

| CMSIS-FreeRTOS

| core
| crypto

| csp

| dev_packs

L _mhc
)
| net

7 apps

| config

| doc
| docs
| driver

| net_pres

| sys_adapter

| tcpip
| templates

. __mnfs aenerator

Include in library ~

r I
l\ | tepip_discoverer ||

src
| web_pages
| wolfssl
| Lab_Manuals
| labl

2 items

v| 5 I | Searcht.. R ‘

Share with v Burn New folder B= v N o
~
Name Date modified Type
L src 02.06.2019 18:27 File folder
=
L L tcpip_discovererJ 02.06.2019 18:27 Executable Jar File
-~ < 1 »
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34. If Windows is asking for permissions allow the access

§#F Windows Security Alert 5

Windows Firewall has blocked some features of‘his

program

Windows Firewall has blocked some features of Java(TM) Platform SE binary on all public and
private networks.

¢ Name: java(TM) Platform SE binal
=’
‘ <= ) Publisher: Oracle Corporation

Path: C:\program files\java\jre1.8.0_121\bin\javaw.exe

Allow Java(TM) Platform SE binary to communicate on these networks:

]7 Private networks, such as my home or work network

[] Public networks, such as those in airports and coffee shops (not recommended
because these networks often have little or no security)

What are the risks of allowing a program through a firewall?

! Allow access l [ Cancel

35. The TCP Discover should list all boards in the classroom. We have made this tool to help you to find your board in the

network. The source codes of this tool (Java) are part of the H3.

You can identify your board by the Host Name that has select in an earlier step. The Host Name is also known to the

DHCP server and is listed in their typical Web Interfaces as a connected device.

2 Microchip TCPIP Discoverer o B s

| Discover Devices ] [] Network Direct Broadcast [ Exit

. Microchip Devices
(= 1. Harmony

[=- |, MAC-Address - fc:c2:3d:0c:20:44
=} 1. MAC-Type

- CAAAC
—

“"="7 Hostname .
- # MARTIN_RUPPERT

=F9 1P Addresses
~-# 192.168.0.17
# fe80:0:0:0:fec2:3dff:fe0c:2044
~- % 2a02:908:1d41:d520:fec2:3dff:fe0c:2044
[=}- . Multicast Listeners
=@ ff02:0:0:0:0:1:ff0c:2044
# ff02:0:0:0:0:0:0:1

D

Date - Nov.12 2018
Version - TCPIP Discoverer 3.0

-

Press the IDiscover Devicesl button: The tool will send a UDP broadcast on port 30303, with the packet “Discovery,

who is out there?” All H3 devices running the Announce service will respond to this broadcast, by sending a return

broadcast on port 30303. The broadcast packet contains data on the type of interface used, the Host Name, MAC and IP

Address. The Discover tool listens to all broadcasts on port 30303 and will show found devices under the Microchip

25
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Devices tree. You can identify your device by looking for the host name that you entered in MHC Setup process. The

Microchip TCPIP Discoverer tool also shows the IP address for your board.

36. A double click on the MAC-Address line will put you in your default Internet Browser

W Microchip TCPIP Discoverer o] & ”ﬂl

[ Discover Devices ] || Network Direct Broadcast [ Exit ]

.. Microchip Devices
=}/, Harmon
(ERIMEMAC-Address - fc:c2:3d:0c:20:44

[=} | MAC-Type

(=} 1. Hostname

----- # MARTIN_RUPPERT
[=} . IP Addresses
. - ® 192.168.0.17

- # fe80:0:0:0:fec2:3dff:fe0c:2044
. - # 2a02:908:1d41:d520:fec2:3dff:fe0c:2044
[=}- | Multicast Listeners
# f02:0:0:0:0:1:ff0c:2044
- # ff02:0:0:0:0:0:0:1

Date - Nov.12 2018
Version - TCPIP Discoverer 3.0

37. And the Webpage is displayed. Please take some time an play with the sub menus to find out the capabilities of or H3
Web Server

=& % |
@ Microchip TCP/IP Stack Demo A X +
C O @ Notsecure | 192168.0.17 ¥ O @ [[Ho Q> 6

A8\ MicrocHip

HARMONY
-

TCP/IP Stack Demo Application

Welcome!
LED:
Dynamic Variables .
Stack Version: 7.32 - H3.2
SSI Processing i " Jun 32019 Buttons:
Build Date: 19:20:58 R
e E::aiiv::?m FLASH Random Number:
Authentication File System Type: MPFS2 47152
Cookies This site demonstrates the power, flexibility,
and scalability of a 32-bit embedded web server. Everything you see is
Uploading Files powered by a Microchip PIC microcontroller running the Harmony Microchip

TCP/IP Stack.
Sending Emails

On the right you'll see the current status of the demo board. For a quick
Dynamic DNS example, click the LEDs to toggle the lights on the board. Press the push
buttons (except MCLR!) and you'll see the status update immediately. This
[— examples uses AJAX techniques to provide real-time feedback.
Confioustion This site is provided as a tutorial for the various features of the HTTP web
p— server, including:
Configuration « Dynamic Variable Substitution - display real-time data
+ Server Side Includes - process real-time SSI commands
« Processing Forms - handle input from the client
« Authentication - require a user name and password
+ Cookies - store session state information for richer applications
+ Uploading Files - parse files for configuration settings and more

Several example applications are also provided for updating configuration
parameters, sending emails, and controlling the Dynamic DNS client. Thanks
to built-in GZIP compression support, all these tutorials and examples fit in
the 32kB of on-board Memory.

For more information on the Harmony TCP/IP Stack, please refer to the
TCP/IP Stack Libraries Help paragraph in the MPLAB Harmony Help installed
on your computer as part of the Harmony distribution.

37. Congratulations, you have completed Lab 1!

26




23075 loT6 Simplifying TCP/IP Applications with MPLAB® Harmony

Lab 2

Overview

You will be implementing an embedded network application to update and track status of an Vending Machine (VM).

The implementation is sectioned into two modules.

TASK 1:

. . E70 HTTP- SERVER E70 HTTP-SERVER
The task is to interface the up/down and select buttons and an OLED of a

Vending Machine to the HTTP-Server. The HTTP-Server keeps track of the

/Vending Machine -1 /Vending Machine-(n)

items in the Vending Machine.
The HTTP- Client (PC-web page) talks to the HTTP- server and displays the
status of the Vending Machine. The HTTP-Client also sends out an update Ethernet Switch

request to the HTTP- server using Ethernet Interface.

PC — HTTP-Client (1) PC- HTTP-Client ()
3\ MicrocHiP
HARMONY
-
TCP/IP Stack Demo Application
m Vending Machine Demo
= following the question mark (?) in your browser's address bar. Data sent via
e e e e o o e, et e FrS comaciin aca
buffer. Your application will handle the data in the TCPIP_HTTP_GetExecute
callback. TCPIP_HTTP_ArgGet function provides an easy method to retrieve
submitted values for processing.
As an example, this GET form gets count of the VM items as user input and

Network

Configuration VM TRACKER

snmp

i i Coca- .

Conflguration S0 | cola | pepst | BI_.. | Minute | ranca | asan:
Vending Machine Diet

Demo

9 9 9 9 9 9 9
Copyright © 2018 Microchip Technology, Inc.
The task is to make all the VMs in the class network to talk to a server. When a SERVER

Bay of a VM is empty it sends out a message to a common server.
An example Message:

“Message: 1 from Martin: The Pepsi Bay is empty” BRI
The Message number (1) and the Host name (Martin) together forms a unique

Message and makes it easy to differentiate your message from other VMs on the

E70 HTTP-SERVER / E70 HTTP- SERVER /
Vending Machine (1) Vending Machine (n)

network server and the number helps to find the recent ones.

Data Protocol

27
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TASK1

TASK 2

28

TCP HTTP Port 80

GET /VM.htm?ITEM=2&COUNT=5

TCP HTTP Port 80

Sends the request “GET /MY_Data.xml
HTTP/1.1” for every 500ms

TCP HTTP Port 80

HTTP/1.1 200 OK
Sends the MY_Data.xml file to
update the web page with

| BAY Empty Message |

PC HTTP-Client-1

LIDNATE

] L I ] ] L] PCHTTP-Client-1

o PC -HTTP-Client-1

BAY Empty Message

BAY Empty Message
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Application Implementation
The Vending Machine demo (Task 1 and 2) is implemented using “SAME70Xplained Ultra Evaluation Kit “and “OLEDI1 XplainedPro
ExtensionKit”. The OLED Xplained pro has three buttons, LEDs and an OLED.
» The VM application uses Button 1(Down) and 2(UP) to scroll through the VM items and Button 3 to select an item
from the Vending Machine.
» The LEDs above the button indicates a button press with a blink.
» The OLED is used to display the name and their corresponding number of the items in a Vending Machine.
» When select button(B3) is pressed the HTTP-Server will decrement the count of an item and updates the HTTP-
Client(Web page)through ethernet interface.

E70 WEB SERVER
/Vending Machine

29
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The Vending machine demo runs the below user applications in conjunction with MPLAB Harmony TCP/IP Stack:
e OLED and Button Contoller (MMI_Tasks): Manages the operation of the OLED display , Buttons and LEDs.

o Application Contoller (app_Tasks()): manages all high level network communications with client and server.

File: main.c

File: tasks.c
Function : SYS_Tasks()

FUNCTION : SYS_Tasks()

SYS_FS_TASKS()

NET_PRES_Tasks ()

SYS_CMD_TASKS()

DRV_MIIM_TASKSs ()

NET_PRES_Tasks ()

TCPIP_STACK_Tasks ()

30




23075 loT6 Simplifying TCP/IP Applications with MPLAB® Harmony

Lab Procedure

In Lab 1, you configured a new MPLAB Harmony Project from scratch that included the TCP/IP Stack middleware and a LED
Flasher. The project you created in Lab 1 will be used as the starting point for Lab 2.. The source code for the OLED and Button
Controller are included into the project.

You will learn about several Harmony TCP/IP API functions by adding the necessary APls into the application source code to
manage the TCP Sockets and data exchanged with socket. You will also learn how the dynamic variables in a web page are
handled by the server. Finally, you will get to use the Packet Sender software tool to perform isolated testing of the embedded
application prior to connecting your VM implementation to the server on the network.

Lab Procedure

Project Setup

1.2. Close Lab 1 project by choosing File»Close Project(lab1) in the main menu.

8 MPLAB X IDE v5.20 - web_net_server_nvm_mpfs_freertos_lab1

File Edit View Navigate Source Refactor Production Debug

EI New Project...
9 New File...

Open Project...
Open Recent Project

Import

l Close Project (web_net_server_nvm_mpfs_freertos_lab1) ]

Close Other Projects
Close All Projects
Open File...

Open Recent File

Project Groups...

Project Properties (web_net_server_nvm_mpfs_freertos_lab1)

1.3. The project for Lab 2 has already been setup in advance. The project is a working implementation of Lab 1 that has been
renamed to web_net_server_nvm_mpfs_lab2, and has a number of files added including mmi.c and modified app.c file

are added to the project. To open the Lab 2 project, choose File»Open Project in the main menu.

8 MPLAB X IDE v5.20 - web_net_server_nvm_n

File Edit View Navigate Source Refactor Pn

T New Project...
9 New File...

Open Project...
Open Recent Project

Import

1.4. Inthe Open Project window, enter C:\MASTERs\21070\ web_net_server_nvm_mpfs_lab2\firmware into the File name

text box or navigate to the file .

1.5. Clickon sam_e70_xult_freetos.X icon in the file list.
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1.6. Press|Open Project.

¢ D Lookiin: lab2 v ﬁ(
= _ .
LS - Project Name:
Recent Items = - feamware L
[ sam_e?U_qut_freertos.X web_net_server_nvm_mpfs_freertos_lab2
[ src
. Open Required Projects:
Desktop
Documents
This PC
@ File name: C:\MASTERs\23075Vjab2\firmware\sam_e70_xult_freertos.X Open Project
Network
Files of type:  project Folder v Cancel

1.7. The source and header structure for the project is shown below.

=-Gakueb net server nvm mofs freertos lab2)

({5 Header Files
- (@ Important Files

G-(fF] Linker Files

=" Source Files

ranfin
-

custom_http_net_app.c

----- E] mpfs_net_ima.c
osal
web_pages
Gaﬁ' Libraries

ﬁ Loadables
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MHC Code Generation

1.8. The project configurations are already set, and we are going to look on the configurations and generate the code. (steps
1.8-1.22)

1.9. Before the MHC Configuration tool can be used, you need to set lab2 as the main project, by right clicking on the

web_net_server_nvm_mpfs_lab2 folder under the Projects window, and choosing Set as Main Project in the popup
menu.

Run
Debug
Step into

[ Important Fies
i) Linker Fies
= E' Source Files

Make and Program Device

-5 app.c Set as Main Project %
i @ config Open Required Projects >
i @ custom_http_net_app.c Close

1.10. To launch MHC, choose Tools»Embedded»MPLAB Harmony 3 Configurator in the main menu.

|Too|s IWindow Help

Embedded p 2
&

MPLAB® Harmony 3 Framework Downloader
MPLAB® Harmony 3 Configurator

Licenses

1.11. In the MPLAB Harmony Launcher dialog box, make sure the path states

C:\MASTERs\23075\h3 and click on .

‘2 MPLAB Harmony Launcher [
Active Project Information:

Name: sam_e70_xult_freertos

Select an option to use for the launch paths for the MPLAB Harmony Framework tool suite:

(. -
l (@) MPLAB Harmony Project Path - The framework path that is stored with this MPLAB Harmony project. Reconfigure Paths

Harmony Path: C:\MASTERs\23075\h3

(7) MPLABX Path - The framework path that is stored with MPLABX (configured through Tools->Options->Harmony)

Harmony Path: C:\microchip\h3

Default Launch Action: iPrumpt For Path Selection (This... V:
(Configurable through Tools->0ptions->MPLAB Harmony)

L taunch [ Gancei |
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1.12. In the nest window the H3 parts and their used Version Number are displayed. Click on

-2 Configuration Database Setup
Select and configure the packages that will be included in the current project:
o9
Load Name Version Dependencies
v| |bsp v3.3.0 csp(3.2.1)
V| lcore v3.2.1 csp(3.2.1)
V| |crypto v3.2.1 core(v3.2.1)
csp v3.2.1
[« Inet v3.3.0 core(3.2.1), csp(3.2.1), dev_packs(...

Configure Device Family and CMSIS Pack Paths:

DFP: .\dev_packs\Microchip\SAME70_DFP\4.0.26\same70b\atdf\AT SAME70Q218.atdf )
CMSIS: \dev_packs\arm\CMSIS\5.4.0 E]
[ teunch |} [ Cancel ]

1.13. Open the saved state file

=]
~

Open default saved state file?

C:\WASTERs\23075\ab2\firmware\src\config\sam_e70_xult_freertos\sam_e70_xult_freertos.xml

| Open ; Cancel

1.14. Explore and look on the configurations tree by clicking on the modules under Active Components (step 1.14 and 1.15- can
be skipped and continue from 1.16).

1.15. Click and check the “Core” option under Active Components. On right hand side the Configuration options are displayed,
check the “Number of Applications “options under Configuration Options which is set to 2.Expand both Application 0 and
1 Configuration trees, and the Application Name is set to app (Application Interface) for Application 0, and mmi(Man
Managed Interface for buttons, leds and OLED)for Application 1.

1.16. Check on TCP/IP Stack under Active components and its configuration under Configuration options.

il Active Components ] c Configuration Options l Help =l
ile pects
;PI DR T =

= Core

CMSIS Pack = Generate Harmony Aspplication Files

OLE =-application Configuration
Fumber of Applications 2 :l

ryp ographic (Crypto) Library = application 0 Configuration
EFC pplication Name app
ppRHCation narme mos e vall -Language identif
FILE SYSTEM RTOS Configuration
FreeRTOS =-application 1 Configuration
= MEMORY Application Name mmi
#- Presentation Layer = entif
SAM E70 Xplained Ultra BSP RTOS Configuration
SPIO Enable System Interrupt
Enable System Ports (I
SYStem Enable System Cache
TCO Enable System DMA [
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1.17. Select the Instance 0 in the TCP/IP stack under Active Components to enter the HOST Name (TCP/IP STACK->BASIC

CONFIGURATION->Instance 0). And change in the Configuration Options (displayed on the right side of MPlabx) the Host

Name to your firstname_lastname. The Host name can be identified in the Network.

[CI Active Components =B
X TomE®m e [Configuration Options* | Help
CMSIS Pack = =
CONSOLE
Core EHNETCONFIG
(E:;Z:ptographlc (Crypto) Library Network Configurations Index 0
FILE SYSTEM Interface GMAC
[” FreeRTOS Host Name RAJI_SHAN
+ MEMORY
# Presentation Layer Mac Address 00:04:25:1C:A0:02
SAM E70 Xplained Ultra BSP IPv4 Static Address 192.168.100.11
System
0 IPv4 SubNet Mask 255.255.255.0
=T CP/IP STACK IPv4 Default Gateway Address | 192.168.100.1
+-_APP A ON | A R .
=(BASIiC cONFIGURATION e LUILEL (21 192.168.100.1
= NETCONFIG IPv4 Secondary DNS 0.0.0.0
Power M full
TCP/IP Basic Configurator owe e
TCPIP CMD #Network Configuration Start-up Flags
TCPIP CORE Network MAC Driver DRV_GMAC_Object
TCPIP File System Wrapper
#- DRIVER LAYER
- NETWORK LAYER
- TRANSPORT LAYER
TIME

1.18. Select “Code” (Generate Code) which is under the menu tabs.

Z  MPLAB Harmony Configurator - sam_e/(

‘ile Generate Toaole _Lltilitiac \Window

"1 Active Comnanents
1.19. Select Don’t Save

2 Modified Configuration

Current configuration has been modified. Do you want to save it before file generation?

I[ Don't Save i ||

Save As
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1.20.

1.21.

36

Select Generate

rs

2 Generate Project

1. Configure Generation Settings

[ Generate Settings

Merge Strategy [USER RECENT

(Mouse over a property for detailed help)

2. View Warnings

Type Description

3. Click Generate

Generate

Cancel

Some Files will be changed, and the MHC is asking in a “diff” window, if the changes should be taken over. Accept all

changes in the file by clicking on the Arrow in the middle above and then close.

2 Me .

1

Pending Merge Actions: 1 & nex 4 Previous I Close I
Note:
Generated Code I Current Fie: configuration.h_7137651041604723379.0ld
akd 2
define ICPIP IPV6 NDP_MAX RTR SOLICITATION DELAY 1 326 326 $define ICPIP IPV6 NDP_MAX RTR SOLICITATION DELAY 1
define 4 327 327 $define ICPIP IPV6 NDP RTR SOLICITATION INTERVAL 4
define 3 328 328  #define ICPIP IPV6 NDE MAX RTR SOLICITATION: 3
define ST_: 3 329 329 #define ICPIP IPV6 NDE MAX MULTICAST SOLICIT 3
define ICEIP IPV6 NDP MAX UNICAST SOLICIT 3 330 330 #define ICPIP IPV6 NDP MAX UNICAST SOLICIT 3
define ICPIP_IPV6 NDP_MAX ANYCAST DELAY TIME 1 331 331 #define ICPIP_IPV6 NDP_MAX_ANYCAST DELAY_TIME 1
define ICPIP IPV6 NDP_MAX NEIGHBOR_ADVERTISEMENT 3 332 332 $define ICPIP IPVE NDP_MAX NEIGHBOR_ADVERTISEMENT 3
define TCPIP IPVe NDP_REACHABLE TIME 30 333 333 $define ICPIP IPV6 NDP_REACHABLE TIME 30
define TCPIF IPVe NDP RETRANS TIMER 1 334 334 #define ICPIP IFV6 NDE_RETRANS TIMER 1
define TCEIP IPVe NDP DELAY FIRST_PROBE_TIME s 335 335  #define ICPIP IFV6 NDE DELAY FIRST_PROBE_TIME s
define TCPIP IPV6 NDP_VALID_LIFETIME_TWO_HOURS (60 * €0 * 2) 336 336 #define ICPIP IPV6 NDP_VALID_LIFETIME TWO_HOURS (60 * 60 * 2)
define ICPIP IPV6 MTU_INCREASE_TIMEOUT &00 337 337 #define ICPIP_IPV6 MTU_INCREASE_TIMEOUT €00
define ICPIP IPV6 NDP_TASK TIMER RATE 32 338 338 $define ICPIP IPV6 NDP_TASK TIMER RATE 32
339 339
340 340
* Network Configuration Index 0 341 341 /* Network Configuration Index O
define ICPIP NETWORK DEFAULT_INTERFACE NAME_IDXO  "GMAC" 342 342 #define ICPIP NETWORK_DEFAULT_INTERFACE_NAME IDXO  "GMAC"
define ICEIP IF_GMAC 343 343 #define ICPIP IF_GMAC
342 344
define ICPTP NETWORK DEFAULT HOST NAME IDXO "RAJT SHAN" =9 345 345 Fdefine ICPIP NETWORK DEFAULT HOST NAME IDXO "HCHEBORRD G
define ICPIP NETWORK DEFAULT_MAC ADDR_IDXO "00:04:25:1C:R0:02" T 346  #define ICPIP NETWORK_DEFAULT_MAC ADDR IDXO "00:04:25:1C:A0: 02"
347 347
define ICPIP NETWORK DEFAULT_IP_ADDRESS_IDXO "192.168.100.11" 348 348 #define ICPIP NETWORK_DEFAULT_IP ADDRESS_IDXO "192.168.100.11"
define % "255.255.255.0" 349 349 #define ICPIP NETWORK DEFAULT_IE MASK_IDXO "255.255.255.0"
define "192.168.100.1" 350 350 $define ICPIP NETWORK_DEFAULT_GATEWAY_IDXO "192.168.100.1"
define "192.168.100.1" 351 351 #define ICPIP NETWORK_DEFAULT_DNS_IDXO "192.168.100.1"
define "0.0.0.0" 352 352 #define ICPIP NETWORK_DEFAULT_SECOND_DNS_IDXO "0.0.0.0"
define IC 5 ) _MODE_IDX mrui1m 353 353 #define ICPIP NETWORK DEFAULT_POWER_MODE_IDXO mru11n
define TCPIP NETWORK DEFAULT_INTERFACE FLAGS_IDXO \ 354 354  #define ICPIP NETWORK DEFAULT_INTERFACE_FLAGS_IDXO \
TCPIP_NETWORK CONFIG DHCE CLIENT_ON I\ 355 355 ICPIP NETWORK_CONEIG DHCP CLIENT ON |\
TCPIP_NETWORK_CONFIG_DNS_CLIENT_ON I\ 356 356 TCPIP_NETWORK_CONFIG_DNS_CLIENT_ON I\
TCPIP_NETWORK_CONFIG_IP_STATIC 357 357 TCRIP_NETWORK_CONFIG_IP_STATIC
358 358
define TCPIP NETWORK DEFAULT_MAC DRIVER IDXO DRV_GMAC Object 359 359 #define ICPIP NETWORK_DEFAULT_MAC_DRIVER_IDXO DRV_GMAC Object
360 360
361 361
362 362
#++ tepip cmd Configuration *+4/ 363 363 /*** tcpip omd Configuration *4*/
define ICPIP STA( MMAND_ENABLE 364 364 $define ICPIP_STACK COMMAND_ENABLE
Aefine TCRTP STACK COMMANDS TCMP FCHO RFONURSTS s 68 365 #define TCPTP STACK COMMANDS TCMP FCHO RFOURSTS a
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1.22. The whole process is displayed with a progress bar

‘2 Generating Project...
Task Type Remaining Total
File Markup 1) 482
File Copy 52, 482
Libraries 0 0
Settings 8 8
Source Paths il 0

Generating file: C:\MASTERs\23075\h3\crypto\src\des3.c

1.23. After the MHC has finished generating the project, go to the Projects Window and expand the Header Files and Source
Files to see the source/header files for the app and mmi application file and TCP/IP stack files.
» The WEB page source code for the VM application is found under the folder web-pages->VM.htm
» The hex file for the web page is in mpfs_net_img.c which is generated using the utility MPFS- generator which

comes along with Harmony net package.

' Projects x'l Active Components®
El"-gaweb net server nvm mpfs_freertos_lab2
ﬁ Important Files
~ Linker Files
E} Source Files
config
¢
@-(iF) FreeRTOS
afx_mono

...... B http_net_print.c

-
osal

BE}@ Libraries

ﬁ Loadables
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Application Source and Header File SetupTASK1:

In the VM application when an VM ITEM update is initiated by the HTTP- client (WEB PAGE) it sends out a GET command that
needs to be processed by the HTTP-Server. The get command is sent along with the argument of the VM “Item” to be updated
and its “Count” which are processed by the HTTP-Server. In Harmony TCP/IP stack GET command is handled by the function
TCPIP_HTTP_NET_ConnectionGetExecute ().

Follow the procedure under to include the code that process the GET request from HTTP-CLient: -

1.24. Click and Open the file custom_http_net_app.c. Search for the function TCPIP_HTTP_NET_ConnectionGetExecute ()
(Approx. Line.No. 247) in which the below code snippets need to be inserted.

Projects x Active Components* 7
=] -QBweb_net_server_nvm_mpfs_freertos_lab2
i [F) Header Files
= @ Important Files
- P Makefile
-5 Linker Files
=-(g8) Source Files
: E] app.c
6] config
@
) @ FreeRTOS
- afx_mono
E] http_net_print.c

i E} main.c

-1 T,

=

=+

=

1.25. Find the TODO[1] and insert the below code starting from the line mentioned as “//<--Insert the solution for TODO[4]
starting on this line” . Code can be inserted either by typing or copy and paste which is provided for your convenience at

the end of the file (custom_http_net_app.c).

ptr =TCPIP_HTTP_NET_ArgGet(httpDataBuff, (const uint8_t *)"ITEM");

1.26. Find the TODO[2] and insert the code snippet starting from the line mentioned as “//<--Insert the solution for Item 2
starting on this line” . Code can be inserted either by typing or copy and paste which is provided for your convenience at

the end of the file (custom_http_net_app.c).

ptr =TCPIP_HTTP_NET_ArgGet(httpDataBuff, (const uint8_t *)"COUNT");

VM_Count[Update_Item]=*ptr;

TASK 2:
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When a Bay of the VM is empty it sends out the message to the common server. The sate machine to open a socket to send

message and close socket is shown below

If WEB file is not

mounted

File Mounted Display the IP

address

Wait to READ

read MAC address If new link

found

MAC MAC address

If a VM Bay Set-up TCP

TCP/IP stack Int cizlcor SR SIeE
any new

link

Stack not

Initialized

No link found If wait time out

Wait for
TCP

Wait for

link Link is established Close connection

Connection

Established

Send out the TCP

message

In this section, you will gain some experience with the use of Harmony TCP/IP API functions. The app.c source is missing lines
of code. All missing code specifically relates to management of the setting up the TCP Client such as opening or closing the
socket, checking if the socket is connected, checking if data is available, and writing data to the socket. Your task is to read the

description for each missing item, select the appropriate Harmony TCP/IP API, and fill in the missing line of code.
1.27. The first step to do is get the common server’s IP address. Get the address from the presenter and make a note.

1.28. Click and Open the file app.c. and find the function APP_Tasks (). (Approx. Line.No. 200) in which the below code snippets

are inserted.
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_Projects x: Active Components* |
=] aaweb_net_server_nvm_mpfs_freertos_labz
Erv@ Header Files
Er»% Important Files
-9 Makefile
! @ Linker Files
Erﬁﬁ Source Files
-
E\@ config
i E] custom_http_net_app.c
() FreeRTOS
w5 gfx_mono
E] http_net_print.c

E] main.c

[E'] mpfs_net_ima.c
Ew@ osal
w-[EF) web_pages
@[ Libraries
@ ([@@ Loadables

1.29. Find the TODO[3] in which common SERVER IP address is entered. Replace the x with the common server IP address ().

For example: if the server IP address is 192.168.0.108 replace

* x1 with 192
* x2 with 168
* x3 with 0

* x4 with 108

1.30. Find TODO[4] and add the below snippet to Open a socket for TCP_Client . Code can be inserted either by typing or copy

and paste the code which is provided for your convenience at the end of the file (app.c).

appData.socket = TCPIP_TCP_ClientOpen(IP_ADDRESS TYPE IPV4,

appData.port,

(IP_MULTI_ADDRESS*) & addr);

1.31. Find TODO[5] and add the below snippet to check the TCP connection is established 0.

Insert the code in the line mentioned as “//<--Insert the solution for TODO[5] starting on this line”
Code can be inserted either by typing or copy and paste the code which is provided for your convenience at the end of

the file (app.c).

40




23075 loT6 Simplifying TCP/IP Applications with MPLAB® Harmony

if (ITCPIP_TCP_IsConnected(appData.socket))

1.32. Find TODO[6] and add the below snippet to check the TCP connection is established .
Insert the code in the line mentioned as “//<--Insert the solution for TODO[6] starting on this line”
Code can be inserted either by typing or copy and paste the code which is provided for your convenience at the end of

the file (app.c).

if (TCPIP_TCP_PutlsReady(appData.socket) == 0)

1.33. Find TODO[7] and add the below snippet to send the message to the common server once a TCP connection at port 80 is
established .
Insert the code in the line mentioned as “//<--Insert the solution for TODO[7] starting on this line”
Code can be inserted either by typing or copy and paste the code which is provided for your convenience at the end of

the file (app.c).

sprintf(buffer, "MSG:%d from %s : %s is empty", (int) MessageCounter++, (char *)
TCPIP_HOSTS CONFIGURATION[O].macAddr, (char *) VM_Items[bay_index - 1]);

SYS _CONSOLE_PRINT("Sending message: %s\r\n", buffer);

TCPIP_TCP_ArrayPut(appData.socket, (uint8_t*) buffer, strlen(buffer));

1.34. Find TODO[8] and add the below snippet to close the TCP Client socket.
Insert the code in the line mentioned as “//<--Insert the solution for TODO[8] starting on this line”
Code can be inserted either by typing or copy and paste the code which is provided for your convenience at the end of

the file (app.c).

TCPIP_TCP_Close(appData.socket);
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Hardware Setup

This hardware setup is common to both TASK1 and TASK2. After adding the required code for the application, make the hardware

connections to programme the device and to see the output

CLASS
ETHERNET
NETWORK

1.35. Network Connection

Cable: CATS Ethernet Cable supplied with Starter Kit
Connection: RJ45 Jack from the class network to PCB Top RJ45 Jack(make sure the jumper below the
Ethernet PHY module is taken off)

1.36. Programming and Console Connection

Cable USB Male A to USB Male B Micro cable
Connection: USB Debug Port on PCB Top to Laptop USB Port

1.37. OLED1 Xplained Pro Connection

OLED1 X PLAINED pPrO
Connection: Connect the OLED x PLAINED PRO to the EXT 2 of the board (Extension close to Ethernet
PHY)

1.38. PC

PC needs to be connected to the Class network or
It can be connected to the wireless network
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1.39. In the main window of MPLABX, click on the “Make and Program Device” button

freertos_labl : sam_e70_xult_freertos

v%”; =" -

2| Start Page | MPLAB X Store

MCLI Rnards

1.40. After successful build, the SAME70 is programmed automatically. Build and Programming are monitored on the output

window at the bottom of the MPLAB X IDE screen.

Output x| Console
OutéutLnet_server_nvm_mpfs_freertos_labZ (Build, Load, ...) #2 x web_net_server_nvm_mpfs_freertos_lab2 (Build, Load, ..) x EDBG x

make -f nbproject/Makefile-sam e70_xult_freertos.mk SUBPROJECTS= .build-conf
/23075/1ab2/firmware/sam e

xult_freertos.X'
/sam_e70_xult_freertos.X.production.hex

up to date.
make([l]: Leaving directory '
BUILD SUCCES

Loading code from C:/MAS
Loading completed

freertos/production/sam e70_xult_freertos.X.production.hex. ..

Connecting to programmer. ..
Programming target. ..

Output x| Console

web_net_server_nvm_mpfs_freertos_lab2 (Build, Load, ...) #2 x web_net_server_nvm_mpfs_freertos_lab2 (Build, Load, ...) x EDBG x

Currently loaded versions:
Application version........... 3.37.438 (0x03.0x25.0x01be€)
Target voltage detected

Erasing. ..

The following memory area(s) will be programmed:

program memory: start address = Ox

. end address 0x434££E

[
"

program memory: start address ., end address 0xSEEEEE

configuration memory

Programming complete

1.41. Immediately after programming, you can see the text on the OLED screen in series like the screens below.

Use the Buttons 1 and 2 (Previous and Next item) on the OLED1 Xplained pro to scroll through the items of the Vending

Machine.

Welcome to i - :
Vending B1-UP, B2-Down 1.Coco-Cola IEI

23075 1oT6 Machine B3-Select
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1.42. Now open a Tera Term to see the status of the HTTP server and its IP address.

If Tera Term is still open from Lab 1, click on the window title bar to make it active. If Tera Term needs to be re-opened

and configured, refer the below steps.

| T
[

Open TerraTerm Terminal Program Tera Term and select under” Setup->Serial Port” (in this
case a COM14, but could be a different COM Port number in your case) set the speed to
115200.Match the below set-up and click “OK *”

Tera Term: Serial port setup X
Port: COM14 v
Speed: 115200 v
Data: 8 bit M Cancel
Parity: none v
Stop bits: 1 bit v Help
Flow control: none v

Transmit delay

0 msec/char [] msecfline

1.43. Reset the Board and let the Firmware restart.

RESET swapq

1.44. After some small time, the IP Address should change from 0.0.0.0 to a valid address. Take time to go through the
Initialization messages, MAC address, Host name and the IP address of the HTTP- server displayed on the tera term

terminal.
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web_net_server_num_mpfs_freertos_labhl Jun 6 2019 09:01:3
SYS_Initialize: The MPFS2 File System is mounted
MAC TCPIP_HOSTS_CONFIGURATIONILA].macAddr: fc:c2:3d:0d:21:d4?
TCP/IP Stack: Initialization Started
TCP/IP Stack: Initialization Ended - success

Interface GMAC on host RAJI_SHAN - NBNS enabled

(null) -sends message to the server when a Bay is empty
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1.45. Open a web browser and enter the HTTP- Server IP address that you got on the tera term in the previous step. This opens

a web page (HTTP-Client)

@ MICROCHIP

HARMONY
\/
TCP/IP Stack Demo App!
Welcomel!
LED:
Dynamic Va
Stack Version: 7.32 - H3.2
SSI Processing o . Jun 6 2019 Buttons:
Build Date: 09:01:40 A A A
P ing F i
s s File System FLASH Random Number:
~ - Location: 12993
Authentication File System Type: MPFS2

Cookies This site demonstrates the power, flexibility, and scalability of a 32-bit

_ N embedded web server. Everything you see is powered by a Microchip PIC
Uploading Files microcontroller running the Harmony Microchip TCP/IP Stack.

On the right you'll see the current status of the demo board. For a quick
example, click the LEDs to toggle the lights on the board. Press the push
buttons (except MCLR!) and you'll see the status update immediately. This
examples uses AJAX techniques to provide real-time feedback.

Sending Emails

This site is provided as a tutorial for the various features of the HTTP web
server, including:
SNMP

Configuration +« Dynamic Variable Substitution - display real-time data

Server Side Includes - process real-time SSI commands
Processing Forms - handle input from the client
Authentication - require a user name and password

Cookies - store session state information for richer applications
« Uploading Files - parse files for configuration settings and more

Vending Machine

Several example applications are also provided for updating configuration
parameters, sending emails, and controlling the Dynamic DNS client. Thanks
to built-in GZIP compression support, all these tutorials and examples fit in
the 32kB of on-board Memory.

For more information on the Harmony TCP/IP Stack, please refer to the
TCP/IP Stack Libraries Help paragraph in the MPLAB Harmony Help installed
on your computer as part of the Harmony distribution.

Copyright ® 2018 Microchip Technology, Inc.

1.46. Click on the Vending Machine tab to see the page for the Vending Machine Demo.

RS\ MicrocHip

s

HARMONY
=

@ MicRoCHIP

tion

TCP/IP Stack Demo Ap

EEE Welcome! .
EEZ 3 Vending Machine Demo

Dynamic Variables

Stack Version: 7.32- H3.2
SSI Processing . . Jun 6 2019 Buttons:
Build Date: 01s Dynamic Variables .
" ) 09:01:40 A A A i The GET method appends the data to the end of the URL You'll see this data
e File System FLASH Random Number: SSI Processing following the question mark (?) in your browser's address bar. Data sent via
Location: 12903 GET is automatically decoded, and stored in the current HTTP connection data

(T (B buffer. Your application will handle the data in the TCPIP_HTTP_GetExecute
9 callback. TCPIP_HTTP_ArgGet function provides an easy method to retrieve

Authentication

File System Type:  MPFS2

Cookies This site demonstrates the power, flexibility, and scalability of a 32-bit

46

Uploading Files

Sending Emails

Network
Configurati

SNMP
Configurat

<
o
El
3

embedded web server. Everything you see is powered by a Microchip PIC
microcontroller running the Harmony Microchip TCP/IP Stack.

On the right you'll see the current status of the demo board. For a quick
example, click the LEDs to toggle the lights on the board. Press the push
buttons (except MCLR!) and you'll see the status update immediately. This
examples uses AJAX techniques to provide real-time feedback.

This site is provided as a tutorial for the various features of the HTTP web
server, including:

Dynamic Variable Substitution - display real-time data
Server Side Includes - process real-time SSI commands
Processing Forms - handle input from the client
Authentication - require a user name and password

Cookies - store session state information for richer applications
Uploading Files - parse files for configuration settings and more

Several example applications are also provided for updating configuration
parameters, sending emails, and controlling the Dynamic DNS client. Thanks
to built-in GZIP compression support, all these tutorials and examples fit in
the 32KB of on-board Memory.

For more information on the Harmony TCP/IP Stack, please refer to the
TCP/IP Stack Libraries Help paragraph in the MPLAB Harmony Help installed
on your computer as part of the Harmony distribution.

Copyright © 2018 Microchip Technology, Inc.

Authentication

Uploading Files
Dynamic DNS

Network
Configuration

SNMP
Configuration

Vending Machine

submitted values for processing.

As an example, this GET form gets count of the VM items as user input and
updates the table

COUNT 0 v
UPDATE
VM TRACKER

Coca-
Coca- Cola Pepsi or Sprite | Fanta Dasani
Cola . Pepper

Diet
9 9 9 9 9 9 9

Copyright © 2018 Microchip Technology, Inc.
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1.47. Use the Button 3 on the OLED to pick an item from the VM. The count of the corresponding item on the OLED scren

will be decremented by 1 and is reflected on the Web page as well as on the OLED screen.

1Coco-CoIaI 8 ]

TCP/IP Stack Demo Apj

Vending Machine Demo

The GET method appends the data to the end of the URI. You'll see this data
following the question mark (?) in your browser's address bar. Data sent via
GET is automatically decoded, and stored in the current HTTP connection data
buffer. Your application will handle the data in the TCPIP_HTTP_GetExecute
callback. TCPIP_HTTP_ArgGet function provides an easy method to retrieve
submitted values for processing.

Dynamic Variables
SSI Processing
Processing Forms
Authentication

As an example, this GET form gets count of the VM items as user input and

Cookies updates the table

Uploading Files

ITEM COUNT 0 v

Sending Emails | UPDATE |

VM TRACKER

2
n
a
?
o

Network
Configuration
Coca- Coca- or
SNMP ol cola Pepsi Popper Sprite Fanta Dasani
Configuration Diet
Vending Machine
° ° ° ° ° °

Copyright © 2018 Microchip Technology, Inc

1.48. Check on the VM update. Pick an item and the count to be changed on the WEB page from the ITEM and COUNT drop

down menu. Select update. When an update is selected the WEB page will send a GET command along with the ITEM

number and COUNT to the HTTP-server. The HTTP-server decodes the GET command and displays it on the VM diaply

(OLED).

HARMONY
-

TCP/IP Stack Demo Ap

Vending Machine Demo

Dynamic Variabk
thiaiiaddadinsiedl  The GET method appends the data to the end of the URL. You'll see this data

following the question mark (2) in your browser's address bar. Data sent via
GET is automatically decoded, and stored in the current HTTP connection data
buffer. Your application will handle the data in the TCPIP_HTTP_GetExecute
callback. TCPIP_HTTP_ArgGet function provides an easy method to retrieve
submitted values for processing.

SSI Processing
Processing Forms

Authentication
As an example, this GET form gets count of the VM items as user input and

Cookies updates the table

uploading Files

ITEM 1 JOUNT ov

g

g 9

g d

g

é =

m o

3 n
o
1]
x
o

ATE
1 [RArE]
2
3 TRACKER
Network 4|
Configuration 5
Coca- | Coca- 6
SNMP Cola | Cola | Pepsi | o ... | Serite | Fanta | Dasani
Configuration Diet
Vending Machine
8 9 9 9 9 9 9
Copyright © 2018 Microchip Technology, Inc.
A\ MicrocHIP

A\ MicrocHP

HARMONY
o

TCP/IP Stack Demo Apj

Vending Machine Demo

The GET method appends the data to the end of the URI. You'll see this data
following the question mark (?) in your browser's address bar. Data sent via
GET is automatically decoded, and stored in the current HTTP connection data
buffer. Your application will handle the data in the TCPIP_HTTP_GetExecute
callback. TCPIP_HTTP_ArgGet function provides an easy method to retrieve
submitted values for processing.

o]

As an example, this GET form gets count of the VM items as user input and
updates the table

uploading Files
Sending Emails

Network
Configuration

VM TRACKER |3

C

:
8 9 9 9 4 9 9

5
Coca- Coca- " r 6 e "
cola cola Pepsi | DCoper ||7 ite | Fanta | Dasani
Diet 8
9

Copyright © 2018 Microchip Technology, Inc.

HARMONY
——

TCP/IP Stack Demo Application

Dynamic Variables

SSI Processing

the table

Vending Machine Demo

The GET method appends the data to the end of the URI. You'll see this data
following the question mark (?) in your browser's address bar. Data sent via
GET is automatically decoded, and stored in the current HTTP connection data
buffer. Your application will handle the data in the TCPIP_HTTP_GetExecute
callback. TCPIP_HTTP_ArgGet function provides an easy method to retrieve
submitted values for processing.

As an example, this GET form gets count of the VM items as user input and

Uploading Files I
|

ITEM | o~
| UPDATE |

Dynamic DNS

Authentication

VM TRACKER

Network
Configuration

sSNMP
Configuration

Coca-
cola

Coca-
Cola
Diet

Pepsi

Sprite Fanta Dasani

Pepper

.

Copyright © 2018 Microchip Technology, Inc.
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Example:

On the web page ITEM 4 and its count will be changed to 4 and, also on the OLED.

ITEM O~ COUNT 0~

UPDATE
4. Dr PepperlZl
Sprite Fanta Dasani

= =1 =l

VM TRACKER

Coca-
Cola Pepsi
Diet

8 =l = 4 J

Copyright @ 2018 Microchip Technology, Inc

Coca-
Cola

Dr
Pepper

You have successfully completed TASK 1 and let’s move on to TASK 2.

1.49. To test Task 2, one or more Bay of the VM machine must be Zero. Press the select Button 3 and make one or more item to
zero count. After few second you can see the messages ” Sending VM status “, “Starting Connection” and “TCP Socket

Connected” and the “BAY Empty message” and TCP client closed on the tera term.

1.50. Look at the presenter’s screen to identify your message.

MSG:338 from fc:c2:3d:0d:21:d7 : 2.Diet-Coke is empty

Message No. MAC address which is unique for each VM  Bay empty message
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Lab 3

Overview
In many loT applications, JSON is commonly used as a format in order to transport high-level data in an effective way. It is generally
an alternative to XML. Consider the following example of describing a person named Raji-Niklas Ruppert in JSON-format:
{
“firstName” : “Raji-Niklas”,
“lastName” : “Ruppert”,
“age” : 30,
“address” : {
“streetAddress” : “2355 W Chandler Blvd”,
“city” : “Chandler”,
“state” : “AZ”,
“postalCode” : “85224”,

}

Using this format makes it very easy to communicate between applications requiring information about Raji-Niklas Ruppert.

The advantage of using JSON in embedded applications is that because it is easy to read for humans, it is simple to parse and make
use of. Due to this, it is commonly used to transmit data between a server and a web application. In this lab we are going to
implement an embedded application fetching weather data from a web server. When the application accesses a specific URL
specifying a command with a geographic location, the web server will respond by sending the current weather in JSSON-format to
the web application. The application will be running on our SAME70-boards.

In this lab we will only do very simple parsing (which is one of the strengths using JSON), using standard string operations. There
are however more sophisticated parsers which can be used for more robust and complex applications, while still only consuming a
very limited footprint.

The weather service used in this lab is https://openweathermap.org/. With OpenWeatherMap, there are several services such as

hourly forecast, UV Index, Air pollution and more, all outputting in JSON. With the free account there are limited option to only use
the “Current Weather Data” service. With this service you can request the current weather from different geographic locations.
Depending on by which method (City ID, ZIP Code, Coordinates etc.) the URL call will be slightly different. A full description of the

API can be found here: https://openweathermap.org/current. For this lab we will fetch current weather by city. The following URL

for thisis:
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http://api.openweathermap.org/data/2.5/weather?q={CITY}&APPID={API Key}

The APl Key is unique to each user. This is also how OpenWeatherMap tracks how many requests you attempt. The APl Key is a 15-

byte long hexadecimal string. It can look like this:

ed3da58111974261002c2af4f8e8e81f

In most JSON API:s there is also a well defined format specified, which tells you where the different objects and strings are located

in the JSON-message. From OpenWeatherMap:

50

{"coord":{"lon":-122.09,"1at":37.39},

"sys":{"type":3,"1id":168940, "message" :0.0297, "country":"US", "sunrise":1427723751, "sunset":14
27768967},

"weather":[{"id":800, "main":"Clear","description”:"Sky is Clear","icon":"@1n"}],
"base":"stations",

"main":{"temp":285.68, "humidity":74,"pressure”:1016.8,"temp min":284.82, "temp _max":286.48},
"wind":{"speed":0.96,"deg":285.001},

"clouds":{"all":0},

"dt":1427700245,

"id":e,

"name" :"Mountain View",

"cod":200}
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Application Flow

Lab Outline

¢ Inthe the source code file app,c are TODO's. At this places you have to change the source codes. At the bottom of the app.c
you find the solutions. Either you think about what you have to change, or you just copy the solution at the right place.

e The main purpose of this class is to point you to the crucial points in an Harmony 3 application and not to let you write a
complete TCP application

e The pre-made template is built from the Harmony example project, tcpip_tcp_client.

o First, we will need to declare the APPID_KEY.

o We will then set the host & port of the remote connection static as we will only connect to OpenWeatherMap.

o After this, we will redirect the user input from the command console to a char* buffer to be used in the application.

e Now we have all information required to build the URL from the introduction.

e When we have connected and requested the data, we need to parse the resulting JSON- string (the whole JSON containing
the current weather will be in one string).

e Typically, good practice when you debug JSON-strings is to print the resulting string for you to view with your own eyes that
it looks correct.

e At last, redirect the application to go back to accepting user input.
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Lab Procedure
1. Start by closing any open projects in MPLAB X IDE.

2. Open a new project and choose lab3 -> Firmware -> sam_e70_xult_freertos.X.
3. Open the file app.c located under source files.
4. Go to (CTRL+F) “TODO A”. Enter the correct APPID_KEY. Either you create your own account on OpenWeatherMap or you

take the one written | the class.

37 L

@ TODO A

39 static const char* APPID KEY = ;
40 char jsonBuffer[1024];

41 char cityBuffer([128]:;

42

43

5. Now scroll down to “TODO B”, the function APP_lInitialize.
6. Set the application to connect to the host api.openweathermap.org and the port to 80. This is set to 80 because this call will
be over HTTP.

105
106 memset (jsonBuffer, 0, sizeof (jsonBuffer)):
107 memset (cityBuffer, 0, sizeof (cityBuffer)):
108
108 appData.host = :
110 appData.port =;

111
112 -
113

7. Re-direct the user input from APP_URL_BUFFER to the cityBuffer array. This can be done in several ways, but one is to use

the built-in C function snprintf(char* dest, size_t size, const char *format, ...). The first argument is the destination buffer
(cityBuffer), the second one is the max size to be copied (128, because that is specified in the declaration) and the

formatted input in this scenario is APP_URL_BUFFER. This can be found in “TODO C”.

422 ALEALAr VUNO NLOVLL LTSoUaiL,
200 - -
@ TODO C
202 snprintf(,,):
203 SYS_CONSOLE_PRINT ( y : Es\n , cityBuffer):;
204

8. Scroll down to “TODO D”, the state APP_TCPIP_WAIT_FOR_CONNECTION. In this state we will wait for a connection to be
established. Once established we will send a GET command with the full URL in the format specified in the introduction:

http://api.openweathermap.org/data/2.5/weather?q={CITY}&APPID={API Key}.

2717

278 char pathBuffer[128];

279 snprintf(, 128, data .5/weathe I=%s ID=%s", , R:
280 appData.path = pathBuffer;

281

9. Once the request is sent to the server, the application will go into the APP_TCIPIP_WAIT_FOR_RESPONSE state.
Once the connection is closed, set the next state to be APP_STATE_JSON_PARSE_RETRIEVED_DATA.
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10.

11.

12.

13.

&z

298 if (!TCPIF_TCP_ISCD::ected(appData.f::f%t)) {

299 SYS CONSOLE MESSAGE ("\x - e Closed\r ):
300 o : e

301 appData.state = ;

302 break;

Now go down in the state APP_STATE_JSON_PARSE_RETRIEVED_DATA. One of the first things we want to do after we
have sorted out the JSON-part of the retrieved data is to print the raw JSON-string. This helps us debug & analyse.

313 char* resultingJson;

314 char* pos:;

315

31¢é pos = strstr (jsonBuffer, )’

317 * (&xresultingJdson) = pos;

318

319 .

320 SYS CONSOLE PRINT ("resul Js : Y ts Y , )

In a real application, we would need to first know the format of the JSON message in order to be able to parse it correctly.
To make this lab more efficiently, we will do this backwards. If you look at this example piece of API response from
OpenWeatherMap found in the introduction section to this lab. Looking at the format from the API, we need to calculate
in what position the value of humidity start. The function strstr will cut the resulting Json string at the first occurrence of

“humidity”. A hint is to look at the other blocks where you parse the temperature, pressure and main weather.

322

- vk char* mainHumidityJdson;

324 char* mainHumidtyBuffer;

325

326 :

327 pos = strstr (resultingJdson, )

328 * (&mainHumidityJdson) = pos + ;

329 mainHumidtyBuffer = strtok(mainHumidityJdson, ):
330

Once the parsing is done, we wish to print the values of the main weather, pressure, temperature and humidity.

335 mainMainWeatherBuffer = strtok(mainMainWeatherJson, )z

336

337

338 YS_CONSOLE_PRINT/("\r ent Weathe . : r\nPrelssure: is\r\nTemperature: :2.2f\r\nMain Weather:
338 - | [ WAl

340

Now to complete the loop, we want to go back to the APP_TCPIP_WAITING_FOR_COMMAND state once the JSON-

parsing and printing is done.

> || 359
|
d pry

362
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14. When the build process was correct, then program the E70

15. Open the Terminal program, press the Reset Button

16. When “>” is prompter you can putin “requestWeather <city>”
Or the short form:"rw <city>”
Forex.“r'w Phoenix”

5_CO
Initial
Initial

08,"lat": 45}, "weather": 1802, "main":"C

ather in Phoenix
15
1013
Temperature:
Main ather:

17. At this point you reached the end of the class and can walk outside to check if the current weather report was correct
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MPLAB® Harmony TCP/IP Stack
TCP Module API Function List

Socket Management Functions
TCPIP_TCP_ServerOpen
TCPIP_TCP_ClientOpen
TCPIP_TCP_Close
TCPIP_TCP_Connect
TCPIP_TCP_Bind
TCPIP_TCP_RemoteBind
TCPIP_TCP_IsConnected
TCPIP_TCP_WasReset
TCPIP_TCP_Disconnect
TCPIP_TCP_Abort
TCPIP_TCP_OptionsGet
TCPIP_TCP_OptionsSet
TCPIP_TCP_SocketInfoGet
TCPIP_TCP_SocketNetGet
TCPIP_TCP_SocketNetSet
TCPIP_TCP_SignalHandlerDeregister
TCPIP_TCP_SignalHandlerRegister
TCPIP_TCP_Task

Transmit Data Functions
TCPIP_TCP_Put
TCPIP_TCP_PutlIsReady
TCPIP_TCP_StringPut
TCPIP_TCP_ArrayPut
TCPIP_TCP_Flush
TCPIP_TCP_FifoTxFullGet
TCPIP_TCP_FifoTxFreeGet

TCPIP_TCP_ArrayFind
TCPIP_TCP_Find
TCPIP_TCP_Get
TCPIP_TCP_Peek
TCPIP_TCP_Discard
TCPIP_TCP_FifoRxFreeGet
TCPIP_TCP_FifoSizeAdjust
TCPIP_TCP_FifoRxFullGet
TCPIP_TCP_GetlIsReady
TCPIP_TCP_ArrayGet
TCPIP_TCP_ArrayPeek
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Opens a TCP socket as a server.

Opens a TCP socket as a client.

Disconnects an open socket and destroys the socket handle, releasing the associated resources.
Connects a client socket.

Binds a socket to a local address.

Binds a socket to a remote address.

Determines if a socket has an established connection.

Self-clearing semaphore indicating socket reset.

Disconnects an open socket.

Aborts a connection.

Allows getting the options for a socket like: current RX/TX buffer size, etc.
Allows setting options to a socket like adjust RX/TX buffer size, etc.
Obtains information about a currently open socket.

Gets the current network interface of an TCP socket.

Sets the interface for an TCP socket

Deregisters a previously registered TCP socket signal handler.

Registers a TCP socket signal handler.

Standard TCP/IP stack module task function.

Writes a single byte to a TCP socket.

Determines how much free space is available in the TCP TX buffer.
Writes a null-terminated string to a TCP socket.

Writes an array from a buffer to a TCP socket.

Immediately transmits all pending TX data.

Determines how many bytes are pending in the TCP TX FIFO.

Determines how many bytes are free and could be written in the TCP TX FIFO.

Searches for a string in the TCP RX buffer.

Searches for a byte in the TCP RX buffer.

Retrieves a single byte to a TCP socket.

Peaks at one byte in the TCP RX buffer/FIFO without removing it from the buffer.
Discards any pending data in the RCP RX FIFO.

Determines how many bytes are free in the RX buffer/FIFO.

Adjusts the relative sizes of the RX and TX buffers.

Determines how many bytes are pending in the RX buffer/FIFO.

Determines how many bytes can be read from the TCP RX buffer.

Reads an array of data bytes from a TCP socket's RX buffer/FIFO.

Reads a specified number of data bytes from the TCP RX buffer/FIFO without removing them from
the buffer.
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UDP Module API Function List

Socket Management Functions
TCPIP_UDP_ServerOpen
TCPIP_UDP_ClientOpen
TCPIP_UDP_IsOpened
TCPIP_UDP_IsConnected
TCPIP_UDP_Bind

Opens a UDP socket as a server.

Opens a UDP socket as a client.

Determines if a socket was opened.

Determines if a socket has an established connection.

Bind a socket to a local address and port. This function is meant for client sockets. It assigns
a specific source address and port for a socket.
Bind a socket to a remote address This function is meant for server sockets.

TCPIP_UDP_Remote
TCPIP_UDP_Close
TCPIP_UDP_OptionsGet
TCPIP_UDP_OptionsSet
TCPIP_UDP_SocketinfoGet
TCPIP_UDP_SocketNetGet
TCPIP_UDP_SocketNetSet
TCPIP_UDP_TxOffsetSet
TCPIP_UDP_SourcelPAddressSet
TCPIP_UDP_BcastIPV4AddressSet
TCPIP_UDP_DestinationlPAddressSet
TCPIP_UDP_DestinationPortSet
TCPIP_UDP_Disconnect
TCPIP_UDP_SignalHandlerDeregister
TCPIP_UDP_SignalHandlerRegister
TCPIP_UDP_Task Standard

Closes a UDP socket and frees the handle.

Allows getting the options for a socket such as current RX/TX buffer size, etc.
Allows setting options to a socket like adjust RX/TX buffer size, etc

Returns information about a selected UDP socket.

Gets the network interface of an UDP socket

Sets the network interface for an UDP socket

Moves the pointer within the TX buffer.

Sets the source IP address of a socket

Sets the broadcast IP address of a socket Allows an UDP socket to send broadcasts.
Sets the destination IP address of a socket

Sets the destination port of a socket

Disconnects a UDP socket and re-initializes it.

Deregisters a previously registered UDP socket signal handler.

Registers a UDP socket signal handler.

TCP/IP stack module task function.

TCPIP_UDP_PutlIsReady Determines how many bytes can be written to the UDP socket.
TCPIP_UDP_TxPutlsReady Determines how many bytes can be written to the UDP socket.
TCPIP_UDP_ArrayPut Writes an array of bytes to the UDP socket.
TCPIP_UDP_StringPut Writes a null-terminated string to the UDP socket.
TCPIP_UDP_Put Writes a byte to the UDP socket.

TCPIP_UDP_TxCountGet Returns the amount of bytes written into the UDP socket.
TCPIP_UDP_Flush Transmits all pending data in a UDP socket.

TCPIP_UDP_GetIsReady Determines how many bytes can be read from the UDP socket.
TCPIP_UDP_ArrayGet Reads an array of bytes from the UDP socket.

TCPIP_UDP_Get Reads a byte from the UDP socket.

TCPIP_UDP_RxOffsetSet Moves the read pointer within the socket RX buffer.
TCPIP_UDP_Discard Discards any remaining RX data from a UDP socket.
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Harmony TCP/IP API Subset For all Lab’s

TCP Socket Management Functions

TCPIP_TCP_ArrayGet Function
This function reads an array of data bytes from a TCP socket's RX buffer/FIFO. The data is removed from the FIFO in the process.

Function Prototype

uintl6_t TCPIP_TCP_ArrayGet(
TCP_SOCKET hTCP,
uint8_t* buffer,
uintl6_t len

)E

Preconditions
TCP is initialized.

Parameters
Parameter Description
hTCP The socket from which data is to be read.
buffer Pointer to the array to store data that was read.
len Number of bytes to be read.
Returns
Type Description
uintle_t The number of bytes read from the socket. If less than 1en, the RX FIFO
buffer became empty or the socket is not connected.

TCPIP_TCP_ClientOpen Function
Provides a unified method for opening TCP client sockets. Sockets are created at the TCP module initialization, and can be
claimed with this function and freed using TCPIP_TCP_Abort or TCPIP_TCP_Close. If the remoteAddress != 0 (and the address

pointed by remoteAddress = 0) then the socket will immediately initiate a connection to the remote host.

Function Prototoype

TCP_SOCKET TCPIP_TCP_ClientOpen(
IP ADDRESS TYPE addType,
TCP_PORT remotePort,
IP MULTI ADDRESS* remoteAddress

)E

Preconditions
TCP is initialized.
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Parameters
Parameter Description
addType The type of address being used. Valid values are: IP_ADDRESS_TYPE_IPV4 or
IP_ADDRESS_TYPE_IPV6
remotePort TCP port to connect to. The local port for client sockets will be automatically
picked by the TCP module.
remoteAddress The remote address to be used
Returns
Type Description
TCP_SOCKET Handle - Save this handle and use it when calling all other TCP APIs. If no
sockets of the specified type were available to be opened, the handle will
contain a value equal to INVALID_SOCKET.

TCPIP_TCP_Close Function
Graceful Option Set: If the graceful option is set for the socket (default), a TCPIP_TCP_Disconnect will be tried. If the linger option
is set (default) the TCPIP_TCP_Disconnect will try to send any queued TX data before issuing FIN. If the FIN send operation fails or

the socket is not connected the abort is generated.

Graceful Option Not Set: If the graceful option is not set, or the previous step could not send the FIN, a TCPIP_TCP_Abort is
called, sending a RST to the remote node. Communication is closed, the socket is no longer valid and the associated resources are

freed.

Function Prototype

void TCPIP_TCP_Close(
TCP SOCKET hTCP
)

Preconditions
TCP socket should have been opened with TCPIP_TCP_ServerOpen/TCPIP_TCP_ClientOpen.
hTCP - valid socket

Parameters

Parameter Description

hTCP Handle to the socket to disconnect and close.
Returns

Type Description

Void None

TCPIP_TCP_GetlsReady Function
Call this function to determine how many bytes can be read from the TCP RX buffer. If this function returns zero, the application

must return to the main stack loop before continuing in order to wait for more data to arrive.
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Function Prototype

uintl6_t TCPIP_TCP_GetIsReady(
TCP SOCKET hTCP

)E

Preconditions
TCP is initialized.

Parameters
Parameter Description
hTCP The socket to check.
Returns
Type Description
uintl6_t The number of bytes available to be read from the TCP RX buffer.

TCPIP_TCP_IsConnected Function

This function determines if a socket has an established connection to a remote node. Call this function after calling

TCPIP_TCP_ServerOpen()/TCPIP_TCP_ClientOpen() to determine when the connection is set up and ready for use.

Function Prototype

bool TCPIP_TCP_IsConnected(
TCP SOCKET hTCP
)

Preconditions
TCP is initialized.

Parameters
Parameter Description
hTCP The TCP socket to check.
Returns
Type Description
bool True: the socket is connected
False: the socket is disconnected

TCPIP_TCP_PutlsReady Function

Call this function to determine how many bytes can be written to the TCP TX buffer. If this function returns zero, the application

must return to the main stack loop before continuing in order to transmit more data.

Function Prototype

uintlé6_t TCPIP_TCP_PutIsReady(
TCP_SOCKET hTCP

)E
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Preconditions
TCP is initialized.

Parameters
Parameter Description
hTCP The socket from which data is to be written.
Returns
Type Description
uinti6e_t The number of bytes available to be written in the TCP TX buffer.

TCPIP_TCP_StringPut Function

This function writes a null-terminated string to a TCP socket. The null-terminator is not copied to the socket.

Function Prototype

const uint8_t* TCPIP_TCP_StringPut(
TCP SOCKET hTCP,
const uint8_t* Data

)E

Preconditions
TCP is initialized.

Parameters
Parameter Description
hTCP The socket from which data is to be written.
const uint8_t* Data
Returns
Type Description
const uint8_t* Pointer to the byte following the last byte written to the socket. If this
pointer does not dereference to a NULL byte, the buffer became full or
the socket is not connected.

TCPIP_TCP_WasReset Function

This function is a self-clearing semaphore indicating whether or not a socket has been disconnected since the previous call. This
function works for all possible disconnections: a call to TCPIP_TCP_Disconnect, a FIN from the remote node, or an
acknowledgment timeout caused by the loss of a network link. It also returns true after the first call to TCPIP_TCP_Initialize.

Applications should use this function to reset their state machines.

Function Prototype

bool TCPIP_TCP_WasReset(
TCP_SOCKET hTCP

)E

Preconditions
TCP is initialized.
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Parameters
Parameter Description
hTCP The TCP socket to check.
Returns
Type Description
bool true: the socket was disconnected since the previous call
false: the socket remained connected since the previous call

UDP Socket Management Functions
TCPIP_UDP_ArrayGet Function

This function reads an array of bytes from the UDP socket, while adjusting the current read pointer and decrementing the
remaining bytes available. TCPIP_UDP_GetlsReady should be used before calling this function to get the number of the available

bytes in the socket.

Function Prototype

uintl6_t TCPIP_UDP_ArrayGet(
UDP_SOCKET hUDP,
uint8_t * cData,
uintl6_t wDatalLen

)

Preconditions
UDP socket should have been opened with TCPIP_UDP_ServerOpen/TCPIP_UDP_ClientOpen.
hUDP - valid socket

Parameters
Parameter Description
hUDP UDP Socket Handle
cData The buffer to receive the bytes being read. If NULL, the bytes are simply
discarded
wDatalen Number of bytes to be read from the socket.
Returns
Type Description
uintl6 t The number of bytes successfully read from the UDP buffer. If this value is
less than wDatalen, then the buffer was emptied and no more data is
available.

TCPIP_UDP_Close Function
Closes a UDP socket and frees the handle. Call this function to release a socket and return it to the pool for use by future

communications.
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Function Prototoype

void TCPIP_UDP_Close(
UDP_SOCKET hUDP
)

Preconditions
UDP socket should have been opened with TCPIP_UDP_ServerOpen/TCPIP_UDP_ClientOpen.
hUDP - valid socket

Parameters

Parameter Description

hUDP UDP Socket Handle
Returns

Type Description

void None

TCPIP_UDP_GetlIsReady Function
This function will return the number of bytes that are available in the specified UDP socket RX buffer. The UDP socket
qgueues incoming RX packets in an internal queue. If currently there is no RX packet processed (as a result of retrieving all
available bytes with TCPIP_UDP_ArrayGet, for example), this call will advance the RX packet to be processed to the next
queued packet. If a RX packet is currently processed, the call will return the number of bytes left to be read from this

packet.
Function Prototype

uintl6_t TCPIP_UDP_GetIsReady(
UDP_SOCKET hUDP
)

Preconditions

UDP socket should have been opened with TCPIP_UDP_ServerOpen/TCPIP_UDP_ClientOpen.

hUDP parameter is a valid socket

Parameters
Parameter Description
hUDP UDP Socket Handle
Returns
Type Description
uintl6 t The number of bytes that can be read from the socket.
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TCPIP_UDP_ServerOpen Function

Provides a unified method for opening UDP server sockets.

Function Prototype

)E

UDP_SOCKET TCPIP_UDP_ServerOpen(

IP ADDRESS TYPE addType,
UDP PORT localPort,
IP MULTI ADDRESS* localAddress

Preconditions
UDP is initialized.

Parameters
Parameter Description
IP ADDRESS TYPE addType The type of address being used.
IP_ADDRESS_TYPE_IPV4 or IP_ADDRESS_TYPE_IPV6.
UDP_PORT localPort UDP port on which to listen for connections

IP MULTI ADDRESS* localAddress Local IP address to use. Can be 0 (NULL) if any incoming interface will do.

Returns
Type Description
UDP_SOCKET Handle - Save this handle and use it when calling all other UDP APIs. If no

sockets of the specified type were available to be opened, the handle will

contain a value equal to INVALID_SOCKET.

TCPIP_UDP_SocketinfoGet Function

This function will fill a user passed UDP_SOCKET INFO structure with status of the selected socket

Function Prototype

)E

bool TCPIP_UDP_SocketInfoGet(
UDP SOCKET hUDP,

UDP_SOCKET INFO* pInfo

Preconditions

UDP socket should have been opened with TCPIP_UDP_ServerOpen()/TCPIP_UDP_ClientOpen()().
hUDP - valid socket

pInfo - valid address of a UDP_SOCKET INFO structure

Parameters
Parameter Description
hUDP UDP Socket Handle
pinfo Pointer to UDP_SOCKET INFO to receive socket information
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Returns
Type Description
bool true if call succeeded

false if no such socket or invalid pinfo.

UDP_SOCKET_INFO Structure

Holds information about a UDP Socket

Structure

Memb

typedef struct {

IP _ADDRESS TYPE addressType;

IP MULTI ADDRESS remoteIPaddress;

IP MULTI ADDRESS localIPaddress;

IP MULTI ADDRESS sourceIPaddress;

IP MULTI ADDRESS destIPaddress;

UDP PORT remotePort;
UDP_PORT localPort;
TCPIP NET HANDLE hNet;

} UDP_SOCKET_INFO;

ers

Type
IP_ADDRESS_TYPE
IP_MULTI_ADDRESS
IP_MULTI_ADDRESS
IP_MULTI_ADDRESS
IP_MULTI_ADDRESS
UDP_PORT
UDP_PORT
TCPIP_NET_HANDLE

Member Name
addressType
remoteIPaddress
localIPaddress
sourceIPaddress
destIPaddress
remotePort
localPort

hNet

Description

address type of the socket
current socket destination address
current socket source address

source address of the last packet
destination address of the last packet

Port number associated with remote node
local port number

associated interface
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